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CHAPTER I 

INTRODUCTION 

General Overview 

Ground water has been an important water resource throughout the ages. 

Approximately half of our Nation's water supply is obtained from aquifers. 

One important role of the water scientists is to assess the quality of water 

supplies and provide information useful in assisting resource managers and 

policy makers in making wise decisions. The quality of ground water is 

affected by physical, chemical, biological, and human activities. The natural 

quality of ground water is determined largely by the types of rocks with which 

the water comes in contact. The interrelationship between surface and 

ground water also has a significant effect on the water quality. 

. The majority of ground-water samples collected for chemical analysis are 

obtained for site specific investigations. This information generally is studied 

and analyzed to address a concern that is of a local scale. The regional study 

described here relies on data that were collected by others; most probably were 

collected as a part of smaller scale studies focused on local problems. The 

fundamental working assumption is that a regional investigation provides a 

broader view and understanding of our overall ground-water system. 
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Purpose and Scope 

The purpose of this study is to develop a computer-based method of 

mapping ground-water quality on a regional scale, and to use this method to 

map selected ground-water constituents in North Dakota, South Dakota, 

Nebraska, Kansas, and Oklahoma (Figure 1). The chemical constituents used 

in this study include total dissolved solids, hardness, chloride, nitrate, and 

sulfate. The representation of ground-water quality can be done in a variety 

of fashions, and various types of graphical represe~tation are discussed in the 

following section. Chemical constituents in this investigation will be 

displayed by range of concentration and by geographic location. This 

information can be used for general assessment of ground-water quality 

conditions at a specific location. It does not necessarily depict current 

conditions at a specific aquifer. The vast majority of samples were drawn 

from the major aquifer in the area. 

Chemical Constituents 

Introduction. Five chemical constituents were examined during this 

investigation. These included total dissolved solids, hardness, chloride, 

sulfate, and nitrate. These were selected because they are common 

constituents found in all ground water. Water samples are often analyzed for 

common chemical constituents. 

Total Dissolved Solids. Total dissolved solids expresses the total 

concentration of dissolved minerals in water. The measurement is 

determined by the weight of residue remaining from a sample after 

evaporation at 180 degrees Celsius. The solid residue invariably consists of 

inorganic constituents and very small amounts of organic matter (Freeze and 
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Cherry, 1979). This measurement is commonly used in the general 

classification scheme presented in Table 1. 

Hardness. Hardness is a term used to describe a property of water. It has 

no established limit for public supplies, however, it is an important 

constituent because even moderate concentrations lead to the build up of 

scale. Hardness is commonly expressed as the total concentration of calcium 

and magnesium as milligrams per liter equivalent of calcium carbonate. 

4 

Total hardness is the sum of temporary hardness and permanent hardness. 

Temporary or carbonate hardness is calcium and magnesium carbonates that 

would be removed by boiling which precipitates calcium carbonate. 

Permanent or noncarbonate hardness is the calcium and magnesium that 

would exist as sulfates that would not be removed by boiling (Hounslow, 

1991). Hard water requires more soap to produce suds, leaves an insoluble 

residue when combined with soap, and precipitates excessive scale formations 

when used in boilers. The terms "hard" and "soft" are inexact and have 

meaning only in the relative sense. Table 2 summarizes three hardness 

classifications. 

Chloride. Waters with chloride concentrations in excess of 250 mg/1 may 

exhibit objectionable taste characteristics. Most shallow natural ground water 

generally contains relatively low levels of chloride. Chloride occurs as the 

predominate anion in sea water where the average concentration is about 

19,000 mg/1 (Driscoll, 1987). Rain water in coastal regions generally contains 

higher concentrations of chloride than noncoastal regions. Common sources 

for chloride are precipitation, thermal waters, halite, saltwater intrusion, 

sewage leachate, oil-field brine, and road deicing salts. 



Category 

Fresh water 

Brackish water 

Saline water 

Brine water 

TABLE 1 

SIMPLE GROUNDWATER CLASSIFICATION 
BASED ON TOTAL DISSOVLED SOLIDS 

Total Dissolved Solids 
(mg/1) 

0-1000 

1000- 10,000 

10,000- 100,000 

More than 100,000 

Freeze and Cherry, 1979. 
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TABLE 2 

SELECTED HARDNESS CLASSIFICATIONS 

Hardness range (mg/1 of CaC03) 

Classification 1 

0-60 
61 -120 
121 -180 
Greater than 180 

Classification 2 

0-60 

Description 

Soft 
Moderately Hard 
Hard 
Very Hard 

Soft 
Excessive scale formation 

6 

Greater than 60 - 80 
Greater than 80- 120 
Greater than 150 

Common community practice to soften water 
Very Hard 

Classification 3 

0-50 
50-150 
100-150 
Greater than 150 

Soft 
Acceptable for most uses 
Scale formation 
Quite noticable scale formation and 
staining 

Classification 1 modified from Hem, 1989. 
Classification 2 modified from Freeze and Cherry, 1979. 
Classification 3 modified from Driscoll, 1987. 



7 

Sulfate. The recommended limit of sulfate in public water supplies is 250 

mg/1. Waters with high levels of sulfate may impart a bitter taste. For people 

not accustomed to elevated sulfate concentrations, these waters may act as a 

laxative. Common sources are gypsum, anhydrite, pyrite, thermal waters, 

from the combustion of fossil fuels and smelting of ores. 

Nitrate. Nitrate-nitrogen (N03-N) concentrations above 10 mg/1 are 

cause for concern due to its toxic effect on infant children and some animals. 

It can cause methemoglobinemia or blue babies in infants. Cattle experience 

loss of milk production and aborted calves. Unlike most other elements in 

ground water, nitrate is not derived primarily from earth materials. Nitrate 

enters ground water from the nitrogen cycle in the earth's hydrosphere and 

biosphere. It is generally expressed as nitrate as N03, or nitrate as N (1 mg/1 

N equals 4.5 mg/1 N03). Nitrate can not be removed by boiling. Common 

sources of nitrate are barnyards, sewage lagoons, and agricultural chemicals. 

Drinking Water Standards 

The Environmental Protection Agency (E.P.A.) established drinking water 

standards by direction of the Safe Drinking Water Act. Primary maximum 

contaminant levels (MCLs) were established for materials that propose a 

health risk, such as nitrate. Secondary maximum contaminant levels govern 

substances that can affect the aesthetic quality of water by adverse taste, color, 

odor, or by staining. The E.P.A. also established recommended concentration 

limits for dissolved solids and nitrate relative for use as crop irrigation and 

livestock production. Table 3 outlines drinking water standards as they apply 

to this investigation. 



TABLE 3 

SELECTED WATER QUALITY STANDARDS 

Constituent 

TDS 
Chloride 
Sulfate 
Nitrate as N 

Constituent 

TDS 
Small Animals 
Poultry 
Other Animals 

Nitrate as N 

TDS - Total dissolved solids 

Drinking Water 

Primary MCL 
(mg/1) 

10 

Crop and Livestock 

Standard 

Secondary MCL 
(mg/D 

500* 
250 
250 

Recommended 
concentration limit (mg/1) 

Livestock 

3000 
5000 
7000 
10 

Irrigation Crop 

700 

MCL - Maximum contaminant level 
* Concentrations of 1000 mg/1 are acceptable where levels below 500 mg/1 

can not be obtained. 

Modified from Driscoll, 1987 and Freeze and Cherry, 1979. 
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Previous Investigations 

Studies that address ground-water quality on a national, regional, or state 

scale are relatively few compared to some of the other geologic subdisciplines. 

One of the most complete works was published by the U.S. Geological Survey 

(1988). This nationwide study describes the ground-water quality of the major 

aquifers in each state. Analyses were obtained from the data base, 

WATSTORE, the U.S. Geological Survey's National Water Data Storage and 

Retrieval System. Chemical constituents evaluated include dissolved solids 

and hardness. Other constituents evaluated varied from common major 

ions to radionuclides. The analyses were grouped by major aquifers and 

graphically displayed as statistical percentiles (Figure 2). 

In 1979 Pettyjohn and others published a ground-water atlas of the Nation. 

The purpose of this study was to develop a series of general maps for each 

state that showed the chemical quality of drinking water that was obtained 

from aquifers in rural America. Rural America was defined as population 

centers of less than 10,000 people. The primary data source was ground water 

quality records obtained from the U.S. Geological Survey in the form of 

magnetic tapes. Some published state and federal water analyses also were 

used. Chemical variables mapped were: (1) total dissolved solids, (2) 

hardness, (3) chloride, (4) sulfate, (5) calcium plus magnesium and (6) 

sodium plus potassium. Data were displayed with two chemical variables per 

map; one variable represented by contour intervals and the other by a range 

of concentration (Figure 3). Statistics used in the evaluation were maximum, 

minimum, mean, and standard deviation for each chemical variable. 

In 1986 Congress appropriated funds to the U.S. Geological Survey to test 

and refine concepts for a national water-quality assessment (NAQWA) 



PRINCIPAL AQUIFat - Alluvial Uld Terrace Aqullen 0) 

~ High Plaina (2) - Ruah Springs (3) .. Dog Creek - Blaine (4) 

c:J . Garber - Welllngton (5) 

~ Vamoosa - Ada (6) .. RDubidoux (7) 

IIIIIIIIlJ Arbuckle - Simpeon (8) 

mm Albudde - Timber Hilla (9) 

~ ' Azttlen (1 0) 

~ Keokuk - Reeds Sprinp (11) 

....... ~~ ...... ~-.'!1D 

lOO.OOO 
... .. . .O.OOO ~ 11 01 •o ,. n 11 

B WATII-QUAUTY DATA 
.._ceft~Me - ""cem.tt ot.....,... ~ 

IE tDO,OOO 
~ 10.000 ---to or ... "'-" ~eo ,...,.. s 

~-
~10000 ~ 

1!11• s . s 

'e~ , 1~~·l -
o!r a-'-• ~.re 

c lOOO 

~ ~ - f 1.000 f -lOIII -" " 100 .......... .... tne-...... ... ,.., .. 5 100 i -- Maa"""'" ~ concenwwm ...... ,~.,._.,, 

I • - - "'-•"""'"' recommeno.c~ ~~ 
._.,~, 10 i 10 ----··········· ~rt10011"'91ewtwtftl 

u 
..,Colt metftOCI ..... 

I 2 J • 5 • ' e • 1 2 J . 5 • ' e • 
~ ....... ~ ....... 

Figure 2. Box-and-Whisker Plots, Principle Aquifers of Oklahoma (Modified from 
U.S.G.S., 1988) 

10 



....._(-.JI) 

0 1:»-:MO 

!Zj :Z~ 

[!) 400-750 

Nrrr.._. ...... __ _..,. (-.JI) 

Figure 3. Data Represented by Contours and by Range of Concentration (Pettyjohn 
and Others, 1979) 

11 



12 

program. The programs goals were: (1) provide a nationally consistent 

description of the water-quality conditions for a large part of the Nation's 

water resources, (2) define long-term trends (or lack of trends) in water 

quality, and (3) identify, describe, and explain, as possible, the major factors 

that affect observed water-quality conditions and trends (Parkhurst and 

others, 1989). Three ground-water and four-surface water pilot studies were 

conducted to refine water-quality assessment and to determine the need for a 

full scale program. One of the ground-water pilot studies was conducted by 

Parkhurst and others (1989). This study described the Central Oklahoma 

Aquifer. Water-quality data for the aquifer was obtained from the following 

local, state and federal agencies: (1) Association of Central Oklahoma 

Governments, (2) Oklahoma State Department of Health, (3) Oklahoma 

Water Resources Board, (4) U.S. Department of Defense, (5) U.S. Department 

of Energy, and (6) U.S. Geological Survey. Analyses that could be associated 

with specific geographical location and the U.S.G.S. well inventory procedure 

were mapped. Chemical constituents investigated were inorganic 

compounds, organic compounds and radionuclides. Figure 4 depicts the 

method of data mapping. 

Sprinkle and others (1983) conducted a ground-water quality study for the 

state of Kentucky. Although this report does not lie within the present study 

area, their methods of investigating ground-water quality on a regional scale 

warrant review. The primary objectives of the Sprinkle study were to 

examine the computer files of the U.S. Geological Survey and (1) determine if 

the data needed to describe the ground-water quality of Kentucky were 

available, (2) identify errors and deficiencies in the data, and (3) to the extent 

possible, use the available data to describe ground-water quality by major 

geohydrologic units. The data used included analyses collected from wells 
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and springs before October 1981 that were accessed from the WATSTORE 

database. The water was analyzed for physical properties, such as temperature 

and color, as well as chemical properties such as major inorganic ions, 

nutrients, trace elements, radionuclides, and organic chemicals. Principle 

water-bearing formations were combined into 10 retrieval groups based on 

geological age. For each retrieval group dissolved solids were mapped by 

means of color code by range of concentration. Analyses that were considered 

to be complete and ionically balanced were plotted on quadrilinear diagrams 

(Figure 5). The statistical parameters selected to characterize the major 

dissolved constituents and physical properties were: (1) maximum, (2) 

minimum, (3) median, and (4) the 75 percent and 25 percent quartiles. 

Frequency bar graphs of dissolved solids, chloride, sulfate, and hardness were 

prepared for each retrieval group. 

Durfor and Becker (1962) prepared the hydrologic investigation atlas of the 

United States and Puerto Rico. This study addresses the selected quality of 

water supplies for population centers exceeding 2,500 residents. The data used 

were obtained from district offices of the U.S. Geological Survey, as well as 

from published and unpublished data from local, county, and state agencies. 

The findings are shown on eight maps that depict the dissolved solids, 

sodium, fluoride, and hardness of untreated and finished water supplies of 

1,596 municipal water systems (Figure 6). Also included is a table 

summarizing the population served by the municipal systems, number of 

systems surveyed, and a trend of hardness concentration from 1922 to 1962. 

Feth and others (1965) investigated dissolved solids concentrations and 

their depth. This study was conducted on a national scale. Two maps of scale 

1: 3,168,000 summarizes the data, which was collected by the U.S. Geological 

Survey in cooperation with state, local, and federal agencies. The Depth and 
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Distribution of Mineralized Water map shows dissolved-solid concentration 

by color coded-ranges. Depth to shallowest zone that contains mineralized 

water is shown by patterned depth ranges. The Chemical Types of Water map 

uses pie diagrams to represent graphically major ions found in water. Figure 

7 diagrams the example used from the study. 
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Socli&m plus Pot&ni&m 

Chlozicle 

1) The size of the pie represents concentration ranges of dissolved solids. 
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2) The subdivisions in the top half of the pie represent percentage compositions of the 
following positive ions: (1) calcium, (2) magnesium, and (3) sodium or sodium plus potassium. 
The sum of equivalents of these positive ions was assumed to be 100 percent and the percentage 
of each was calculated from that base. The bottom half of the pie represents percentage 
compositions of the following negative ions: (1) bicarbonate or bicarbonate plus carbonate, (2) 
sulfate, and (3) chloride. Similarly, the sum of equivalents of negative ions was taken to be 100 
percent and the percentage of each was calculated from that base. 
3) Where one constituent makes up 51 percent or more of the total cations (calcium= 68% in 
example 1) and one makes up 51 percent or more of the total anions (sulfate = 75 % in example 1), 
the major cation and major anion give their names to the water type - calcium sulfate in 
example 1. 
4) Where no constituent makes up as much as 50 percent of the cations or none makes up 50 
percent of the anions, the constituent making up the largest percentage is named first; the 
second largest follows as a subsidary term (examples 2 and 3). The subdivisions of the 
hemisphere is diagrammatic, the dominated cation or anion occupying two-thirds of the 
hemisphere and the second highest one third, regardless of the actual proportions between 
them. Rarely, all three major cations ( or three anions) are virtually equal in percentage. 

Examples 

• ~ . 
Example 1 Example 2 Example 3 

% % % 
~atiQns 
Calcium 68 5 21 
Magnesium 11 21 35 
Sodium 21 74 46 

AniQns 
Bicarbonate 22 40 15 
Sulfate 75 35 48 
Chloride 3 25 37 

Calcium sulfate magnesium Sodium magnesium 
type water bicarbonate sulfate chloride 

sulfate type type water 
water 

Figure 7. Data Represented by Pie Diagram with Explanation (Modified From Feth and 
Others, 1965) 



CHAPTER II 

DESCRIPTION OF THE STUDY AREA 

Location and Physiography 

The study area includes North Dakota, South Dakota, Nebraska, Kansas, 

and Oklahoma in the central United States. With the exception of far eastern 

Oklahoma the area lies within the Great Plains and Central Lowlands 

physiographic provinces (Figure 8). The Great Plains province is 

characterized by flat upland plains and valleys that are broad, shallow and 

steep-sided. Low rolling hills and dissected till plains shape the landscape of 

the Central Lowland province. In Oklahoma's eastern margin low 

mountains with subparallel ridges and valleys form the Ozark Plateaus and 

Ouichita provinces. Gently sloping plains make up the Coastal Plains 

physiographic province in southeastern Oklahoma. 

Generalized Geology of the Region 

The study area principally occupies parts of the Nonglaciated Central, 

Glaciated Central, High Plains and Alluvial Valleys ground-water regions 

(Figure 9). Small areas in North Dakota and South Dakota lie in the 

Northeast and Superior Uplands region and Western Mountain Ranges 

region, respectively. Both the Glaciated and Nonglaciated Central regions are 

underlain by gently dipping Paleozoic to Tertiary age bedrock that consists 

primarily of sandstone, shale, and limestone. The Glacial region is mantled 
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I .>.._.I Alluvial Valleys 

Figure 9. Continued 
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by till, loess, and outwash sediments deposited during Pliestocene age glacial 

episodes. The High Plains region is underlain by Permian to Cretaceous age 

sedimentary rock that dips gently to the east. Overlying these strata is an 

alluvial apron deposited by streams that flowed eastward from the Rocky 

Mountains. These Tertiary deposits consist of unconsolidated to 

semiconsolidated gravel, sand, silt, and clay known as the Ogallala 

Formation. Recent deposits of eolian dune sands overlie the Ogallala in parts 

of Nebraska, Kansas and Oklahoma. The Alluvial Valley region is not one of 

geographic continuity, but rather one of geologic origin. Alluvial valleys are 

occupied by thick sand and gravel deposits that are in hydraulic contact with a 

perennial stream. These channel deposits generally do not extend beyond the 

floodplain and adjacent alluvial terraces. 

Regional Precipitation Pattern 

Precipitation varies greatly in the study area (Figure 10). Average annual 

precipitation ranges from less than 16 inches in the western margin to over 52 

inches in southeastern Oklahoma. Contour lines representing precipitation 

amounts trend generally in a north-south lineation and increases from west 

to east in the region. The amount of precipitation has a significant effect on 

ground-water recharge, quality, and streamflow. 

Occurrence of Ground Water in the Area 

This region, consisting of approximately 377,000 square miles, is quite 

diverse in geology and water resources. The glaciated area contains ground 

water in surficial and buried deposits of sand and gravel, as well as in 

extensive pre- and interglacial valleys. Commonly, these aquifers provide 
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Figure 10. Average Annual Precipitation in the Study Area 
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large quantities of water to wells. The chemical quality of the ground water 

although generally very hard, is useful for domestic, municipal, industrial 

supplies, as well as irrigation. Ground water obtained from wells tapping 

glacial till is generally highly mineralized and well yields usually range from 

less than one to several gallons per minute. 

The Non-glaciated Central Region contains ground water in sedimentary 

bedrock aquifers that range from Tertiary age in North Dakota to middle 

Paleozoic age in Kansas and Oklahoma. These aquifers consist generally of 

sandstone and siltstone with some limestone and gypsum. The Tertiary age 

aquifers in North and South Dakota generally contain water that is soft and 

has high levels of sulfate. This water is suitable for most purposes except 

irrigation. 

The Cretaceous age aquifers in Kansas and Oklahoma yields up to several 

hundreds of gallons per minute of water to wells. The water is generally 

suitable for most uses but is considered hard and highly mineralized in some 

areas. 

Paleozoic age aquifers occupy southeast Kansas and much of Oklahoma. 

The water is considered suitable for domestic, industrial, municipal, and 

irrigation use. Water from these aquifers generally ranges from hard to very 

hard. Well yields commonly range from a few tens to several hundreds of 

gallons per minute. 

Ground water in the High Plains Region occurs in unconsolidated to 

semiconsolidated Tertiary age deposits. These deposits consist of gravel, sand, 

silt, and clay. The saturated thickness of the aquifer ranges from a few feet to 

over 500 feet in some areas (U.S.G.S., 1988). The water is generally suitable for 

public supply, although some areas contain high levels of chloride and 

sulfate. Well yields commonly range from 100 to 1000 gallons per minute. 
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Alluvial valley aquifers occur throughout the study area and are a major 

source of ground water. Fluvial and terrace deposits consist of gravel, sand, 

silt, and clay. This water is used for both public supply and irrigation use. 

The water obtained from alluvial aquifers is considered hard and locally 

contains high levels of dissolved solids, chloride, and sulfate. Wells that tap 

these aquifers may yield several hundreds of gallons per minute. 



CHAPTER III 

METHODOLOGY 

Description of the Data Base 

This study evaluates ground-water quality using data stored on compact 

disks, which were prepared by Earthlnfo, Inc. The associated program, 

Hydrodata QW, accesses WATSTORE data via personal computer. The entire 

file contains about 15,000,000 measurements from about 200,000 sampling 

stations throughout the United States. The data file contains analyses that 

were collected for a variety of purposes. Most of the data was collected by the 

U.S. Geological Survey to meet the objectives of site-specific or subregional 

investigations. Some water samples do not represent natural conditions 

since they were collected during or after episodes of contamination. To 

conserve funds, these studies restricted the analyses of ground water samples 

to major inorganic constituents. Relatively few samples were analyzed for 

organic chemicals or trace elements. 

The Hydrodata QW program was operated on a 386-type personal 

computer with compact disc optical drive. Selected chemical analyses were 

obtained by filtering the data through location, analysis type, and parameter 

criteria. The data used for this investigation were taken from only ground 

water samples in each state. 
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Computer Hardware 

The computer hardware used in this investigation is as follows: (1) 386 

IBM compatible personal computer with 40 megabyte hardrive and an optical 

disk (CD-ROM) drive by Hitachi, (2) Macintosh Ilci desktop computer by 

Apple with a removable hardrive by SyQuest, and (3) Laser Writer II printer, 

also by Apple. 

Computer Software 

Computer software was an essential part of the gathering, organizing, and 

mapping the water-quality data. The computer programs used on the 

personal computer or PC include: (1) Hydrodata QW by Earthlnfo, (2) 

Wordstar by MicroPro, and (3) SEP100 by Kelly Goff. Programs used on the 

Macintosh are: (1) Atlas MapMaker 4.5 by Strategic Mapping, (2) Apple File 

Exchange 1.1.1 by Apple, (3) Microsoft Word 4.0 by Microsoft, (4) Microsoft 

Excel by Microsoft, and (5) SuperPaint 1.1 by Bill Snider. 



CHAPTER IV 

PROCEDURE 

Data Base Search 

The analyses were obtained from Hydrodata QW by specifying a distinct 

search path or query. One query was run for each of the five states. Each 

query consisted of the state, all samples that were drawn only from a well, and 

the 20 constituents (the Hydro QW program labels constituents as parameters) 

listed on Table 4. Once the search was complete the analyses were saved to 

the hardrive as a state file. Complete computer steps and commands are 

listed in the Appendix. 

Analyses Editing 

Each sample analysis contains concentrations of selected constituents and 

a station location identification code. The identification code is a 14 digit 

number representing latitude and longitude in degrees, minutes and seconds, 

as well as a sequence positioning code. To map the location of the well and 

express a measurement on MapMaker the data must be put in a specific 

format. Latitude and longitude can only be read from a file in decimal form. 

Every sample was not tested for all parameters requested. For example, some 

samples were only tested for hardness and chloride, while others were tested 

for all 20 parameters. Again, due to the requirements of Map Maker, each 

parameter must be listed in the file in a specific position or category. Each 

29 
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TABLE 4 

PARAMETERS SEARCHED IN THE DATA BASE 

Parameter Units 

Total dissolved solids mg/l 
Hardness mg/1 
Chloride mg/1 
Sulfate mg/1 
Nitrate as N mg/1 
Temperature celcius 

Specific Conductance micromhos 
Bicarbonate mg/1 
pH standard units 
Calcium mg/1 
Magnesium mg/l 
Sodium mg/1 
Potassium mg/1 
Fluoride mg/1 
Silica mg/1 
Boron ug/l 
Iron ug/l 
Nitrate as N03 mg/1 
Depth of well feet 
Depth to water feet 
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state file was run through SEP100 in order to create a decimal form location 

file and a data file with parameters in the appropriate categories. The location 

and data files were then edited in Wordstar to remove unwanted spaces 

between data. Once the data were edited, the files were of a manageable size, 
c 

containing approximately 800 kilobytes, that could be transferred to a high 

density 3.5 inch floppy disk. A disk was prepared for each state, placed into 

the Macintosh and then run through the Apple File Exchange program. This 

process allows the Macintosh to read a file that was created on a PC. 

Mapping 

The MapMaker program contains a variety of boundary files such as the 

outline of a state. One also can combine several boundary files to make a 

map. The imported latitude-longitude file was converted to a boundary file 

and then combined with the state outline boundary file. The combined file 

was used to create a map showing the locations of all sampling stations in 

that state. Once this map was created, the data file containing the 

measurements for each of the 20 chemical parameters was imported into each 

map file. The maps shown in this investigation were created by selecting a 

state, a chemical parameter, and a specific range of concentration. 



CHAPTER V 

GROUND-WATER QUALITY BY STATE 

North Dakota 

General Setting 

North Dakota contains approximately 71,000 square miles. Annual 

average precipitation ranges from less than 14 inches in the western part of 

the state to about 20 inches in the southeast. Western North Dakota is 

principally drained by southeastern flowing Missouri River network. The 

eastern part of the state is drained by the north flowing Red River of the 

North and its tributaries. 

North Dakota is underlain by Paleozoic to Tertiary age clastic and 

carbonate rock. The bedrock dips gently westward into the Williston Basin in 

the western part of the state. These units thin to the east and primarily 

consist of shale, sandstone, and limestone. All but the southwest part of 

North Dakota is overlain by unconsolidated glaciofluvial, glaciolacustrine 

and glacial till deposits of Quaternary age. 

Discussion 

Table 5 exhibits the number of analyses measured, percentage of samples 

that exceed E.P.A. drinking water standards, and percentage in each range of 

concentration. A map of the major aquifers in North Dakota and their 

descriptions is depicted in Figures 11 and 12. Maps illustrating the location of 
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wells and selected ground water quality in North Dakota are shown in 

Figures 13-43. 
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Eighty five percent of the ground-water samples tested for total dissolved 

solids in North Dakota exceed the recommended limit of 500 mg/1, and 57 

percent of those sampled exceed 1000 mg/1. The high concentrations appear 

to be rather evenly distributed throughout the state, without regard to major 

aquifers present (Figure 15 and 16). Data in Table 5 suggests that much of the 

dissolved solids concentration is related to the presence of sulfate. The 

sulfate may have been derived from gypsum, which is widely distributed 

throughout the state. 

More than 7700 samples have been analyzed for hardness in North 

Dakota. About 68 percent of those samples exceed 180 mg/1, which is 

considered very hard water. This reflects the wide spread distribution of 

carbonate material and gypsum, particularly the glacial till. About 18 percent 

of the samples contain water that would by considered soft, that is, less than 

60 mg/1 of hardness. Ground water in the Tertiary strata is characteristically 

soft, owing to the abundance of sodium and the lack of calcium in the water. 

Soft water appears to be most abundant in the southwestern part of the state 

where Tertiary strata crop out. Elsewhere the strata is covered by glacial till, 

which contains hard water. 

Over 8700 samples were analyzed for chloride in the state. 81 percent 

contain water which measured less than 125 mg/1 of chloride, and is 

distributed somewhat evenly throughout the state. Figures 27 and 28 

indicate that waters with higher concentrations are located in the north­

central and eastern parts of the state. Although some of the higher chloride 

concentrations may be the result of contamination, perhaps caused by oil-field 

activities, the elevated values present in the eastern third of the state are 



probably related to upward leakage from the Dakota Sandstone and other 

bedrock aquifers. 
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Only 4 percent of the samples analyzed for nitrate as N and nitrate as N03 

exceed the recommended levels. Maps of wells where nitrate was measured 

indicate a fairly even distribution throughout the state. High concentrations 

may be related to poor well construction, which allows nitrate-rich waters, 

such as barnyard wastes, to infiltrate around the well bore. In some cases 

nitrate concentrations may be related to agricultural practices. In other cases 

high values are the result of leaching of decaying organic matter from the 

millions of potholes, which are naturally occuring undrained depressions, 

which are characteristic of the glaciated regions. 
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TABLES 

NORTH DAKOTA: NUMERICAL SUMMARIES 
OF WATER ANALYSES 

Chemical EPA Water Percentage Percentage 
Constituent Number Quality Exceeding in Each 
by Range of of Standard EPA Range of 

Concentration (mg/1) Samples (mg/1) Standard (%) Concentration(%) 

TDS 500"' 85 • 
All Samples 7632 • • 
0-500 1184 • 16 
501 -1000 2103 • 28 
Greater than 1000 4345 • 57 
Equal to or Greater Than • • 

the 90th Percentile 646 • 8 

Hardness None • • 
All Samples 7815 • • 
0-60 1432 • 18 
61 -120 546 • 7 
121 -180 509 • 7 
Greater than 180 5328 • 68 
Equal to or Greater Than • • 

the 90th Percentile 793 • 10 

Chloride 250 13 • 
All Samples 8736 • • 
0-125 7058 • 81 
126-250 564 • 6 
Greater than 250 1106 • 13 
Equal to or Greater Than • • 

the 90th Percentile 871 • 10 

Sulfate 250 49 • 
All Samples 8402 • • 
0-125 2602 • 31 
126-250 1682 • 20 
Greater than 250 4118 • 49 
Equal to or Greater Than • • 

the 90th Percentile 846 • 10 
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TABLE 5 (continued) 

Chemical EPA Water Percentage Percentage 
Constituent Number Quality Exceeding in Each 
by Range of of Standard EPA Range of 

Concentration (mg/1) Samples (mg/1) Standard (%) Concentration(%) 

NitrateasN 10 4 • 
All Samples 5365 • • 
0-5 5069 • 95 
6-10 92 • 2 
Greater than 10 204 • 4 
Equal to or Greater Than • • 

the 90th Percentile 539 • 10 

Nitrate as N03 45 4 • 
All Samples 6715 • • 
0-25 6301 • 94 
26-45 115 • 2 
Greater than 45 299 • 4 
Equal to or Greater Than • • 

the 90th Percentile 682 • 10 



EXPLANATION 

- Principle Unconsolidated Aquifers 

- Fort Union Aquifer System 

Q Hell Creek - Fox Hills Aquifer System 

tmmmml Great Plains (Dakota) Aquifer System 

~ Ordovician and Precambrian Rocks 

CJ Madison Group Aquifer (Not Shown) 

Figure 11. North Dakota: Map of Major Aquifers (Modified from U.S.G.S., 1985) 
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(Oal/mill • plloas per minute: ft • f~ct: mJ1L • milli.,....s per liter: Sourc:a: aealolic uti llydrolop: reporU of lllc U.S. CieololicaJ Surwy 
and lllc Nonh Dal<ouo Slate Water Commiuioal 

Well charactertatlel 
Aquifer name and description Depth(fl) Yield (gallmln) Remarka 

Common Common May 
ran!!• r&!!§!! UCMCI 

UIICOIIIOiidated aquifers: 
Eqleyale: Sud, .,.Yd,lilt, 0-10 1-1,000 1,$00 Water lwdto.ay hard. Laqe 

and silly clay. Coafmed COIICCIItrations of iroa (IIIC&II CODCelltralioG 
utlut>CODfmed. of 1.9mJIL) and.....,.._ (IIIC&II 

-....uuiaD of0.4 IIIJIL). Suil&blc for 
irrip&iaa. 

Oaka: Sud, .,.vel, silt, 0-100 1-5110 '700 Willer IDOderalcJy lwd to .ay hard. Locdy 
uti silty clay. Coafmed laqo-....uuiaeaofinla(O.I-IOIIII,IIL). 
utl..-flllltl. SuilaiiJe for ilriplioe. 

Paae: Sud ut1 .,.Yd. 10-110 1-300 5110 Wttter -:y hard. Locally Jarac 
C:O.fuoedutl ..-fmed. COIICIOIIUIIioG or iroa (0.01-0.4 IIIJIL). 

Suil&blc for ilriptioo. 

Spiritwood: Sud uti P11Yd 0-300 1-1,000 1,$00 Wt11er~lwd. Locdylarae 
illlerbedded willl silt COIICIOIIUIIiouofiroo(0.4-9.1 tlllfL). 
utlclay. Coafuoedutl Sailablc for iniplioo. 
-r1110111. 

Sutldre: Sud and .,.vel. 50-300 1-5110 1.000 Willer_.,. liard. OeDerallylarae 
Coafilletl ut1.....,.rmec1. co.....tratioll or iroo (JeDcnlly petiiCr t11u 

liiii,IIL). Suitalllc for public supply or 
irriplioQ. 

Wat Fuso: Sud, P1IYd 100-250 10-1,000 1,]00 Willer liard 10 .ay hard. Suil&blc 
llouklen, uti clayleues. for public supply uti oeleCied illdusuy. 
CoDfmed. 

Coasolidtllecl aquifc"s: 
Fort Unioo aquifer systc:m: 0-900 1-100 150 Willer ...,...Uy 10ft. Sodium llllft11e 

Sandstone, sillltone, clajstoae, bic:uballate water. Locdy iarJe 
utllipitc. COIIClelllratioas of sulfate (~9.600 IIIJIL) 

uti iroll (0.01-421111,11L). Gmcrally DOl 
suil&blc for irriptioo. 

Hell Crcek-FOl< Hills aquifer system: 0-2,000 1-150 300 Water ooft. Sodium bic:arbonatellllfate 
Sandstone, silutODC, claystoae, water. Gmcrally DOt suitable for 
and shale. iJriplion. 

Great Plains aquifer System: 5110-5,5110 10-60 1,000 Willer salinity (meaD diuolwd-eolids 
Sandstone, silutoae, and COitCCIItralioG 7 ,]()() IIIJIL) limiu 111e 10 
shale. oil no:oocry ill -em pan of Slate ud 

ltoek watcriq ill eu~em pan of SWc. 
Madioon Group aquifer: 200-6,000 - HiPJy saline (meaD clislolwcJ.Ioli 

Limestone, some IIIUidstone CODCCDtrtllioa 19,000 maiL). Uadeweloped 
utlsbale. iiiSWc. 

Figure 12. North Dakota: Major Aquifer Descriptions and Well Characteristics 
(Modified from U.S.G.S., 1985) 
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Figure 13. 

.. 

.. . 

North Dakota: Locations of Wells From Which Samples Were Collected 
and Analyzed For Total Dissolved Solids 
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Figure 14. North Dakota: Locations of Wells Where Water Contained Total 
Dissolved Solids Concentrations Less Than or Equal to 500 mg/1 
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Figure 15. North Dakota: Locations of Wells Where Water Contained Total 
Dissolved Solids Concentrations Greater Than 500 mg/1 but 
Less Than or Equal to 1000 mg/1 
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Figure 16. North Dakota: Locations of Wells Where Water Contained Total 
Dissolved Solids Concentrations Greater Than 1000 mg/1 

·-· . . 
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Figure 17. North Dakota: Locations of Wells Where Water Contained Total 

Dissolved Solids Concentrations Equal to or Greater Than the 
90th Percentile 
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Figure 18. North Dakota: Locations of Wells From Which Samples Were Collected 
and Analyzed For Hardness 

.. 

Figure 19. North Dakota: Locations of Wells Where Water Contained Hardness 
Concentrations Less Than or Equal to 60 mg/1 
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Figure 20. North Dakota: Locations of Wells Where Water Contained Hardness 
Concentrations Greater Than 60 mg/1 but Less Than or Equal to 
120mg/l 
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Figure 21. North Dakota: Locations of Wells Where Water Contained Hardness 
Concentrations Greater Than 120 mg/1 but Less Than or Equal to 
180mg/l 

43 



• ot. •• - :-

.. 
.. 

Figure 22. North Dakota: Locations of Wells Where Water Contained Hardness 
Concentrations Greater Than 180 mg/1 
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Figure 23. North Dakota: Locations of Wells Where Water Contained Hardness 
Concentrations Equal to or Greater Than the 90th Percentile 
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Figure 24. North Dakota: Locations of Wells From Which Samples Were Collected 
and Analyzed For Chloride 

Figure 25. North Dakota: Locations of Wells Where Water Contained Chloride 
Concentrations Less Than or Equal to 125 mg/1 
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Figure 26. North Dakota: Locations of Wells Where Water Contained Chloride 
Concentrations Greater Than 125 mg/1 but Less Than or Equal to 
250mg/1 

Figure 27. 
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North Dakota: Locations of Wells Where Water Contained Chloride 
Concentrations Greater Than 250 mg/1 
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Figure 28. North Dakota: Locations of Wells Where Water Contained Chloride 
Concentrations Equal to or Greater Than the 90th Percentile 

47 



··• 

Figure 29. North Dakota: Locations of Wells From Which Samples Were Collected 
and Analyzed For Sulfate 
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Figure 30. North Dakota: Locations of Wells Where Water Contained Sulfate 
Concentrations Less Than or Equal to 125 mg/1 
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Figure 31. North Dakota: Locations of Wells Where Water Contained Sulfate 
Concentrations Greater Than 125 mg/1 but Less Than or Equal to 
250mg/l 
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Figure 32. North Dakota: Locations of Wells Where Water Contained Sulfate 
Concentrations Greater Than 250 mg/1 
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Figure 33. North Dakota: Locations of Wells Where Water Contained Sulfate 
Concentrations Equal to or Greater Than the 90th Percentile 
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Figure 34. North Dakota: Locations of Wells From Which Samples Were Collected 
and Analyzed for Nitrate Measured as N 

. . - -. ·.·. 

Figure 35. North Dakota: Locations of Wells Where Water Contained Nitrate 
Concentrations Less Than or Equal to 5 mg/1 as N 
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Figure 36. North Dakota: Locations of Wells Where Water Contained Nitrate 

Concentrations Greater Than 5 mg/1 as N but Less Than or Equal 
to 10 mg/1 as N 
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Figure 37. North Dakota: Locations of Wells Where Water Contained Nitrate 
Concentrations Greater Than 10 mg/1 as N 
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Figure 38. North Dakota: Locations of Wells Where Water Contained Nitrate 
Concentrations, Measured as N, Equal to or Greater Than the 90th 
Percentile 

53 

i ., 



.;. 

Figure 39. North Dakota: Locations of Wells From Which Samples Were Collected 
and Analyzed for Nitrate as N03 
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Figure 40. North Dakota: Locations of Wells Where Water Contained Nitrate 
Concentrations Less Than or Equal to 25 mg/1 as N03 
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Figure 41. North Dakota: Locations of Wells Where Water Contained Nitrate 

Concentrations Greater Than 25 rng/1 as N03 but Less Than or 
Equal to 45 mg/1 as N03 

' 
. ·, .. 

. . . . . . . . . . 

. ...... . .. .. 
• . . .. . .. . . . . . . 

. . . . 

Figure 42. North Dakota: Locations of Wells Where Water Contained Nitrate 
Concentrations Greater Than 45 rng/1 as N03 
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Figure 43. North Dakota: Locations of Wells Where Water Contained Nitrate 
Concentrations, Measured as N03, Equal to or Greater Than the 
90th Percentile 

56 

.· 



57 

South Dakota 

General Setting 

South Dakota contains approximately 77,000 square miles. Annual 

average precipitation varies from about 16 inches in the west-central part of 

the state to over 24 inches in the southeast. Rainfall in the Black Hills in 

southwestern South Dakota ranges from 16 inches· to about 24 inches in the 

higher elevations. The western half of the state is drained by eastern flowing 

rivers that terminate in the southerly flowing Missouri River. Eastern South 

Dakota is principally drained by the James and Big Souix River systems. 

South Dakota is underlain largely by Mesozoic to Paleozoic age clastic 

bedrock that dips westward into the Kennedy Basin. The western flank of the 

basin has been upturned sharply by the intrusion that created the Black Hills. 

Precambrian age metamorphic and igneous rocks crop out in the Black Hills. 

Cretaceous age poorly consolidated fine grained sandstone units occur in 

northwestern South Dakota. Tertiary age rock that is primarily composed of 

interbedded sandstone and shale occurs in south-central South Dakota. The 

eastern half of the state is covered by glacial till and outwash deposits that 

consists of gravel, sand, and silt. 

Discussion 

Table 6 exhibits the number of analyses measured, the percentage of 

samples that exceed E.P.A. drinking water standards, and the percentage in 

each range of concentration. A map of the major aquifers in South Dakota 

and their descriptions is depicted in Figures 44 and 45. Maps illustrating the 

location of wells and selected ground water quality in South Dakota are 

shown in Figures 46-76. 



58 

The data base contained very few ground-water analyses in South Dakota. 

Less than 102 analyses are available for each of the chemical constituents 

addressed in this investigation. Due to this lack of information, it would be 

difficult to make a meaningful assessment of the quality of ground water in 

South Dakota. 
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TABLE6 

SOUTH DAKOTA: NUMERICAL SUMMARIES 
OF WATER ANALYSES 

Chemical EPA Water Percentage Percentage 
Constituent Number Quality Exceeding in Each 
by Range of of Standard EPA Range of 

Concentration (mg/1) Samples (mg/1) Standard(%) Concentration(%) 

TDS 500* 85 • 
All Samples 89 • • 
0-500 33 • 37 
501 -1000 21 • 24 
Greater than 1000 35 • 57 
Equal to or Greater than • • 

the 90th Percentile 8 • 9 

Hardness None • • 
All Samples 85 • • 
0-60 12 • 14 
61-120 6 • 7 
121 -180 5 • 6 
Greater than 180 62 • 73 
Equal to or Greater than • • 

the 90th Percentile 4 • 5 

Chloride 250 12 • 
All Samples 101 • • 
0-125 82 • 81 
126-250 8 • 8 
Greater than 250 12 • 12 
Equal to or Greater than • • 

the 90th Percentile 11 • 11 

Sulfate 250 12 • 
All Samples 17 • • 
0-125 14 • 82 
126-250 1 • 6 
Greater than 250 2 • 12 
Equal to or Greater than • • 

the 90th Percentile 13 • 76 
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TABLE 6 (continued) 

Chemical EPA Water Percentage Percentage 
Constituent Number Quality Exceeding in Each 
by Range of of Standard EPA Range of 

Concentration (mg/1) Samples (mg/1) Standard (%) Concentration (%) 

Nitrate asN 10 12 • 
All Samples 17 • • 
0-5 14 • 82 
6-10 1 • 6 
Greater than 10 2 • 12 
Equal to or Greater than • • 

the 90th Percentile 1 • 6 

Nitrate as N03 45 9 • 
All Samples 33 • • 
0-25 30 • 91 
26-45 0 • 0 
Greater than 45 3 • 9 
Equal to or Greater than • • 

the 90th Percentile 6 • 18 



EXPLANATION 

li: i::: il Glacial Drift and Alluvial Aquifers 

SEDIMENTARY BEDROCK AQUIFERS 

High Plains Aquifer 

Fort Union-Hell Creek-Fox Hills Aquifers 

Niobrara-Codell and Dakota-Newcastle Aquifers 

Inuan Kara, Sundance, Minnelusa, Madison, 
Red River, and Deadwood Aquifers 

CONFINING UNITS AND BASEMENT ROCKS 

- Shale Confining Unit 

- Not a Principle Aquifer 

Figure 44. South Dakota: Map of Major Aquifers (Modified from U.S.G.S., 1985) 

61 



!Ft • feet; pi/min • J&(loas per minute; m1/L • miJblf&IDo per liter. Sources: Rcporu of the U.S. Geoloiical Survey and the Soutn IJuo~< 
GeolQiical Survey) 

Aquifer name and description 

Glacial-drift and alluvial aquifers: 
Outwuh and alluvium; 
uncomolidated S&Dd, .,....,1, and silt. 
May beconfllledor uuconfmed. 

Sedimentary bedroclt aquifers: 
Hilh PlaiJu aquifer: Sand, line 10 

medium; uiiCOIISOiidaled to poorly 
coruolidated oandJtone, silt, 
Jl"8vel, and cbly. UIICOIIIined. 

Fan Ullion-Hell Creek-Fox Hilh 
aquifero: Sandstone, ""'Y rme 10 
fme-paincd, poorly COIISOiicllled; 
soft day; lipite beds. UIICOIIfmed. 

Niabnn-codcD aquifer: Shale, 
cllalty. and f--.raiaed quartz 
IUidsloac. Coafllllld or WICOIIfmed. 

DUoca·Newcutle aquifer: Sandstone, 
interbedded with obaJc and sillllone. 
Confmed. 

lnyan Kara aquifer: Sandstone, 
iDterbeddcd with .... and 
silwone. Coafmed. 

Sundance aquifer: Shale iDtcrbedded 
with r......,..;nec~ llalldaaee, 
limatonc, and aandy sbale. Coafmed. 

Milmclusa aquifer: y., major 
IUidsloac llllilllepUUed by 
limatone, dolomi1e, sbale, and 
IUIIIJdrite beds. Coafmed. 

Madison aquifer: Limcs&one, and 
dolomite coatliniq beds of 
sbale,IUIIlydrite, and balite. 
Coafmed. 

Red Ri""' aquifer: Dolomite and 
dolomitic limatone. Confined. 

o..dwood aquifer: Sandstone, soft, 
IbiD-bedded, olabby dolomiiC and 
limatoae; limcsconc-pebblc 
c:oeaJomcme: and beds or 
llaucoaitic ohale. Confmed. 

Well characteristics 
Depth (It) Yield (gaUmin) Remarks 
Common Common May 

range range exceed. 

20 - 400 3 - 50 %,000 Glacial drift underlies moot of State 

10-570 5-100 

100-1,000 l-40 

150-300 2-JO 

300-4,000 2-50 

200-4,900 5-40 

100-5,400 S-100 

100-6,100 S-100 

100-9,000 10-100 

1,100-9,700 S-100 

40-10,200 

cast of Miuouri Ri""'. Alluvium 
found alon& major weanu. Water 
freoh to moderately oaline; commonly 
suitable for irription. Bil Sioux 
aquifer in -theutern South Dakoca 
yields adequate supplies for Sioux 
Fallo, State'• iarpst city. 

1,500 Most common -=of water 0t1 Pine Ridae 
and Rosebud Indian Reocrvatiom. 
Supplies towns of Martin and Pine Jlidae. 
Some irriplion deYclopment. Water 
qualily aeneraJIY ouitable for most 

500 

300 

1.500 

1,000 

1,000 

4,000 

uocs. Consisu or lower Opllala 
Fonnalion and Arikaree Fonnation 
Mioceneqe. 

MDII commoo -=of waler in northwat­
cm South DUoca. Fox Hilh aquifer oupplies 
tiiWIII of Bison, Lemmoa, and Timber 
La.te. Warer commoaly freoh. 

Used atensively for li~ and domestic 
purposes in central South DUoca and 
IOUtbem James Rj.., basin. Water 
pnerally soft and modentely saline. 

Major soun:c of W&ler for domatic and 
IIOCk we. Supplies W&ler to maoy small 
public-supply systems. Warer commonly 
moclerately oaJine 10 yay oaline. 

COIIIiclend 10 be an underdevelopecloource 
or W&ler lor domcstic and stock we. 
Warerqualityraqa from freoh in 
west 10 moderarely oalillc in east 
to yay oaJiDc in aonh. 

lmponant -=of W&ler for livestock 
ill ceaual pan of Stare. · Warer 
commonly oaJine excepc ncar surface 
expoourcs in the west. 

Major around-water reoervoir. Source 
for stock and domcstic wells in ceatral 
and westcm South Dakoca. Water of 
ouitable qualiry for irriplion (olilhdy 
oaJiDc or frail) obtained from 
ocvera1 welb near outcropo in the 
Black Hilh. Most welb completed in 
Minnelusa flow. 

2.000 May be 111011 imponant bedrock aquifer 
system in South DUoca. Comprises one or 
more aquifers tlult can yield larac 
quantities or frah to saline W&ler uoder 
siplifiCUII arteoian preuurc. SneraJ 
proclucinl welb arc more than 4,000 fl 
deep. Supplies ouch western South O.koca 
tOWIII U Pbilip, Micllancl, Eqic Bune, and 
Dupree. 

1,000 Althoulh 1101 beiq used u a priacipal 
11011rce of water in South Dakota, 
colllidered a major arteoian aquifer. 
Diuol\'ed-solido concentrations may aceed 
60,000 ma/L. Mu:imum waler temperatures 
ofabout l50clqrea Farenhcit reponed. 

500 Except in the Black Hills area, aquifer not 
used, and potcnlial for clevelopment, 
althoulh probably llilnifiCUit, is not 
known. Salinity 11111y ranac from moderately 
oalinc to yay oaline. 

Figure 45. South Dakota: Major Aquifer Descriptions and Well Characteristics 
(Modified from U.S.G.S., 1985) 
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Figure 46. South Dakota: Locations of Wells From Which Samples Were Collected 
and Analyzed For Total Dissolved Solids. 
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Figure 47. South Dakota: Locations of Wells Where Water Contained Total 
Dissolved Solids Concentrations Less Than or Equal to 500 mg/1 
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Figure 48. South Dakota: Locations of Wells Where Water Contained Total 
Dissolved Solids Concentrations Greater Than 500 mg/1 but 
Less Than or Equal to 1000 mg/1 

Figure 49. South Dakota: Locations of Wells Where Water Contained Total 
Dissolved Solids Concentrations Greater Than 1000 mg/1 
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Figure 50. South Dakota: Locations of Wells Where Water Contained Total 

Dissolved Solids Concentrations Equal to or Greater Than the 
90th Percentile 
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Figure 51. South Dakota: Locations of Wells From Which Samples Were Collected 
and Analyzed For Hardness 

Figure 52. South Dakota: Locations of Wells Where Water Contained Hardness 
Concentrations Less 'Than or Equal to 60 mg/l 
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Figure 53. South Dakota: Locations of Wells Where Water Contained Hardness 
Concentrations Greater Than 60 mg/1 but Less Than or Equal to 

120mg/l 
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Figure 54. South Dakota: Locations of Wells Where Water Contained Hardness 
Concentrations Greater Than 120 mg/1 but Less Than or Equal to 
180mg/l 
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Figure 55. South Dakota: Locations of Wells Where Water Contained Hardness 
Concentrations Greater Than 180 mg/1 
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Figure 56. South Dakota: Locations of Wells Where Water Contained Hardness 

Concentrations Equal to or Greater Than the 90th Percentile 
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Figure 57. South Dakota: Locations of Wells From Which Samples Were Collected 
and Analyzed For Chloride 

Figure 58. South Dakota: Locations of Wells Where Water Contained Chloride 
Concentrations Less Than or Equal to 125 mg/1 
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Figure 59. South Dakota: Locations of Wells Where Water Contained Chloride 
Concentrations Greater Than 125 mg/1 but Less Than or Equal to 
250mg/l 

Figure 60. South Dakota: Locations of Wells Where Water Contained Chloride 
Concentrations Greater Than 250 mg/1 
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Figure 61. South Dakota: Locations of Wells Where Water Contained Chloride 

Concentrations Equal to or Greater Than the 90th Percentile 
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Figure 62. South Dakota: Locations of Wells From Which Samples Were Collected 
and Analyzed For Sulfate 
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Figure 63. South Dakota: Locations of Wells Where Water Contained Sulfate 
Concentrations Less Than or Equal to 125 mg/1 
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Figure 64. South Dakota: Locations of Wells Where Water Contained Sulfate 
Concentrations Greater Than 125 mg/1 but Less Than or Equal to 
250mg/1 

. . 

Figure 65. South Dakota: Locations of Wells Where Water Contained Sulfate 
Concentrations Greater Than 250 mg/1 
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Figure 66. South Dakota: Locations of Wells Where Water Contained Sulfate 

Concentrations Equal to or Greater Than the 90th Percentile 
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Figure 67. South Dakota: Locations of Wells From Which Samples Were Collected 
and Analyzed for Nitrate Measured as N 

F~gure 68. South Dakota: Locations of Wells Where Water Contained Nitrate 
Concentrations Less Than or Equal to 5 mg/l as N 
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Figure 69. South Dakota: Locations of Wells Where Water Contained Nitrate 
Concentrations Greater Than 5 mg/1 as N but Less Than or Equal 
to 10 mg/1 as N 

Figure 70. South Dakota: Locations of Wells Where Water Contained Nitrate 
Concentrations Greater Than 10 mg/1 as N 
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Figure 71. South Dakota: Locations of Wells Where Water Contained Nitrate 

Concentrations, Measured as N, Equal to or Greater Than the 90th 
Percentile 
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Figure 72. South Dakota: Locations of Wells From Which Samples Were Collected 
and Analyzed for Nitrate as N03 
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Figure 73. South Dakota: Locations of Wells Where Water Contained Nitrate 
Concentrations Less Than or Equal to 25 mg/1 as N03 
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Figure 74. South Dakota: Locations of Wells Where Water Contained Nitrate 
Concentrations Greater 1ban 25 mg/1 as N03 but Less Than or 
Equal to 45 mg/1 as N03 

Figure 75. South Dakota: Locations of Wells Where Water Contained Nitrate 
Concentrations Greater Than 45 mg/1 as N03 
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Figure 76. South Dakota: Locations of Wells Where Water Contained Nitrate 
Concentrations, Measured as N03, Equal to or Greater Than the 
90th Percentile 

80 



81 

Nebraska 

General Setting 

Nebraska contains approximately 77,000 square miles. Annual average 

precipitation ranges from less than 16 inches in the western part of Nebraska 

to about 32 inches in the southeast. The state is drained by the eastern 

flowing Niobrara, Platte and Republican River systems. These rivers 

terminate in the Missouri River that bounds Nebraska on the east. 

Nebraska is underlain by Paleozoic to Mesozoic age bedrock that dips 

gently into shallow structural basins. These strata are primarily composed of 

shale with some sandstone units. Glacial drift covers much of the bedrock in 

Nebraska's eastern margin. Quaternary age loess, fluvial, and dune sand 

deposits mantle the central region. Much of western Nebraska is covered by 

the Tertiary age Ogallala Formation. This formation consists of 

unconsolidated to semiconsolidated deposits of gravel, sand, silt and clay. 

Discussion 

Table 7 exhibits the number of analyses measured, the percentage of 

samples that exceed E.P.A. drinking water standards, and the percentage in 

each range of concentration. A map of the major aquifers in Nebraska and 

their descriptions is depicted in Figures 77 and 78. Maps illustrating the 

location of wells and selected ground water quality in Nebraska are shown in 

Figures 79-109. 

Over 1600 samples were analyzed for total dissolved solids in Nebraska . 

. About 76 percent contain less than the recommended level of 500 mg/1. 

Approximately 24 percent of those sampled exceed 1000 mg/1. Figures 80 and 

82 indicate that the samples were drawn from the glaciated eastern margin, 



and to a lesser extent, the southern part of Nebraska. Many of those wells 

located in the southern part of the state lie along the Platte River. 

82 

Hardness concentrations exceed 180 mg/1 in 62 percent of those wells 

sampled. Figure 88 shows that the majority of these wells are located in the 

southeastern half of Nebraska. The wells containing very hard water are 

somewhat evenly distributed without regard to major aquifer present (Figure 

77). Figure 85 indicates wells containing soft water are located in central and 

western Nebraska. These areas are occupied by dune sand and fluvial 

deposits of Quaternary age. 

Chloride was measured in over 2500 wells in the state. About 95 percent 

of those samples contained less than or equal to 125 mg/1 of chloride. Of the 

2551 samples measured for sulfate, approximately 10 percent exceed the 

recommended limit of 250 mg/1. Figure 98 shows that these wells are located 

in the glaciated eastern margin and along the Platte River in southern 

Nebraska. 

Data from Table 7 shows that 13 percent of the samples tested for nitrate 

exceed the recommended limits. These wells are predominantly located in 

the eastern half of the state. One common source for nitrate is heavy use of 

some fertilizers. This is most likely to be the cause of higher concentrations 

of nitrate in Nebraska. 
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TABLE 7 

NEBRASKA: NUMERICAL SUMMARIES 
OF WATER ANALYSES 

Chemical EPA Water Percentage Percentage 
Constituent Number Quality Exceeding in Each 
by Range of of Standard EPA Range of 

Concentration (mg/1) Samples (mg/1) Standard (%) Concentration(%) 

TDS 500* 24 • 
All Samples 1603 • • 
0-500 1211 • 76 
501 -1000 251 • 15 
Greater than 1000 141 • 9 
Equal to or Greater Than • • 

the 90th Percentile 163 • 10 

Hardness None • 
All Samples 2519 • • 
0-60 217 • 9 
61 -120 267 • 11 
121 -180 476 • 19 
Greater than 180 1559 • 62 
Equal to or Greater Than • • 

the 90th Percentile 251 • 10 

Chloride 250 3 • 
All Samples 2569 • • 
0-125 2439 • 95 
126-250 42 • 2 
Greater than 250 88 • 3 
Equal to or Greater Than • • 

the 90th Percentile 260 • 10 

Sulfate 250 10 • 
All Samples 2551 • • 
0-125 2066 • 81 
126-250 243 • 9 
Greater than 250 242 • 10 
Equal to or Greater Than • • 

the 90th Percentile 262 • 10 
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TABLE 7 (continued) 

Chemical EPA Water Percentage Percentage 
Constituent Number Quality Exceeding in Each 
by Range of of Standard EPA Range of 

Concentration (mg/1) Samples (mg/1) Standard (%) Concentration(%) 

Nitrate as N 10 10 • 
All Samples 151 • • 
0-5 124 • 82 
6-10 8 • 5 
Greater than 10 19 • 13 
Equal to or Greater Than • • 

the 90th Percentile 16 • 11 

Nitrate as N03 45 13 • 
All Samples 1502 • • 
0-25 1258 • 82 
26-45 124 • 5 
Greater than 45 120 • 13 
Equal to or Greater Than • • 

the 90th Percentile 152 • 10 



EXPLANATION 

UNCONSOLIDATED ALLUVIAL AQUIFERS 

- Valley Alluvial Aquifers 

ll!!Hlmiml Paleovalley Alluvial Aquifers 

CONSOLIDATED SANDSTONE AND CARBONATE 
ROCK AQUIFERS 

f:::::: J High Plains Aquifer System 

~ Niobrara Aquifer 

- Dakota Aquifer System 

B Undifferentiated Aquifers in Cretaceous Rocks 

§ Undifferentiated Aquifers in Paleozoic Rocks 

Figure 77. Nebraska: Map of Major Aquifers (Modified from U.S.G.S., 1985) 
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(Ft • feel; Ill/mill • piJom per lllilluuo; maiL • lllillipuDs per lilcr. Sowas: lleparu of lbe U.S. Geo1oP:aJ Survey and Nebraska ~LII< 
....,.;.] 

Aquifer name and dncrtptlon 

Paloo¥allcy alluvial aqu.ifen: 
V-ICIIidal8d laiiCI, pavd, 
1111, aDd~. Cicbaally 
-riMII. 

Hiah Plailll aquifer-= 1)-egljd·· .. aDd poorly 
CIIIISOiidall!d laiiCI, pavd, 
silt, aDd clay. U-riDid 
to panially alllfiDid. 

UDdiffcrmtlalMI aquifers ill 
em-rocks: Chalk aDd 
1&11Cb10111. u-riDid to 
collfiMcl. 

\JDdiffaeatialod aquifen ill 
Paleozaic rock&: Limc:lt0111, 
dolomite, aDd IUICillODI. 
\JDCODfiDid or putlally 
coariDid ill upper 200 ft; 
alllfiDid at cllptlt. 

Wall charactarltllca 
Depth (It) Yield (gallmln) 
Common Common May 

rMDe rMge exCMCI 

30-100 

50-150 500-1,000 

30-500 500-1.000 

300-750 

75-1,300 10-100 

30-2.200 10-200 

1,500 Dlfferattlablc llllly ill~ wbere 
Hiah Plailll aqu.irerl)'ltcm DOC 

pnl<lll. Locally, - COIII8illl 
eiCIIIiw CIIIICZIIlnliol or iroll. 

1.500 Dlfferauiablc llllly ill~ wbere 
Hiah Plaillsaquifer 1J1t1111 DOC 
~-

2,500 Aquifer IIYIIaD comprioed of lbe 
Opllala Fonowioa aDd 
bydrauJically COI1MCtedl&lld, 
pavd,lilt, aDd clay clepoliu. 
NoapoiDt-aitrate coo•••ini•N 
fram qriculnaal _,_ill .-.1 
- wbere -•er table is ... 
1llu 30 fl below laJid lllrface aDd 
IOib are 81111)'. 

1,000 SipifiCUI-ofwatcrlllllyill 
..... wbere _.,.,. pclnllity bu 
clenloped. Locally merlaiD by 
unuatod Quatenwy laiiCI aDd pavd 
ciepaliu, wllic:llmay be aD adequate 
-of water or IUJbe IIMC!ill 
coojuDcUoD with Niobrara aquifer. 

1.000 LoQDy~ byauwulld 
Qualmwy laiiCI aDd pavd clepooits 
tba&IU)' be a~~ adequate IOIIrCC of 
-or may be lllod iacoaiiiK!ioo 
with t11C DUOI& aqmfcr. Water ill anu 
wbere aquifer 1)'111111 ii....S il 
,_.uy pocablc (Ia& tbaD 1,000 
maiL clialohiiCI egljda) Qcept iD ___ aDd_.._ l...uallcr 

Coull!)' wbere todium cbloricle 1ype 
water with ..... «1,000 maiL clillolwd 
egljda occun. 

750 LoQIIy overlaiD by utunted 
QualcrDuy laiiCI aDd pavd clcpoliu 
tbctiU)' be &DIIdcqllale- or 
-tcr or may be lllod ill coajUDCiioa 
wilh ulldlffaeatiallld aquifers ill 
era- rock&. ~ IIOiids 
aencniiYIUIC ~ I,OOOUid 
1,5001111/L. 

500 LoQDy ovcrlaia by wuratod 
Qu.uenw:y laiiCI Uld pavd dcpolits 
tbalmay be aD acloquate IOIIICC of 
water or IU)' be IIIICI ill CODjiiDCiioD 
with uDdiffcrt:lltiatod aquiftn iD 
Plleozoic roc:ka. Wucr qualil)' 
vuiablc, cliuoiYod IOiids puenlly 
las !baa 1,500 1111/L butiU)' be 
u mucb u 6.000 JIII/L. 

Figure 78. Nebraska: Major Aquifer Descriptions and Well Characteristics 
(Modified from U.S.G.S., 1985) 
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Figure 79. Nebraska: Locations of Wells From Which Samples Were Collected 
and Analyzed For Total Dissolved Solids . 

.. 
~ . . , . . . 

: . : . . . . : . . ,. 
:-J:., 

.. ... 
·. . . .. . 

. ... 
. 

. 
. . . . . 

. 

. 
. 
. ·. . 

. . . 
- I \ . . . 'I-. . . 

. . 
: '·~~~ . 1-~'.:.~~ 

• "'. •• ~ : = '"r .:·..o.~-""T'"__. ... .._,I •. Q 
.., ~ . . .. ·.. ·. =:··-= ·. \:~ :~~-: ~ -~~R: 

~ . .. . ~ ... . ~ . 
Lr---'lr---...J.,,:r---.1,---....r..---1'"--+'...,·..--1 • .. • ' .. : • 

. ..tr.······ ··=··· .... =.·1 'l::. 
• • • ''lot ~l,.. . 

. . . . . . . . . 

~-
. :: . . . : . ~-\ ~& . :~ ~ 

• • • • • • :. • •• • • • .. - ; • .!...k;:::( . .. . . . , 
~ . . . ·t .. : ;.-i~~-: . ..... · . ;..:. ) 

• • ,:·. .. ~ ·-:,":.! .... t-_:~ .... •• ~-·---} 
.) : ·- . . '':... . . ~ . :. . . ..., 

• I -:.-: .. •••.•• •. ••• • • • • • ~· • •• _l 

. · : :: ·.: :{ ·; ·~. , : ~ · .:= .. . . - 1
1
• 1 \ 

: . . :. . ~ . . .. -• .. • .. • 'i. ~ . . . ,- L 

.. ., '\ ,• I . . . . . . 
• ~ . ' .. 

. . . 

. ·. . . .. . . . 

Figure 80. Nebraska: Locations of Wells Where Water Contained Total Dissolved 
Solids Concentrations Less Than or Equal to 500 mg/1 
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Figure 81. Nebraska: Locations of Wells Where Water Contained Total Dissolved 
Solids Concentrations Greater Than 500 mg/1 but Less Than or Equal 
to 1000 mg/1 
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Figure 82. Nebraska: Locations of Wells Where Water Contained Total Dissolved 
Solids Concentrations Greater Than 1000 mg/1 
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Figure 83. Nebraska: Locations of Wells Where Water Contained Total Dissolved 
Solids Concentrations Equal to or Greater Than the 90th Percentile 
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Figure 84. Nebraska: Locations of Wells From Which Samples Were Collected 
and Analyzed For Hardness 
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Figure 85. Nebraska: Locations of Wells Where Water Contained Hardness 
Concentrations Less Than or Equal to 60 mg/1 
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Figure 86. Nebraska: Locations of Wells Where Water Contained Hardness 
Concentrations Greater Than 60 mg/1 but Less Than or Equal to 
120mg/l 
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Figure 87. Nebraska: Locations of Wells Where Water Contained Hardness 
Concentrations Greater Than 120 mg/1 but Less Than or Equal 
to 180mg/l 
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Figure 88. Nebraska: Locations of Wells Where Water Contained Hardness 
Concentrations Greater Than 180 mg/1 
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Figure 89. Nebraska: Locations of Wells Where Water Contained Hardness 
Concentrations Equal to or Greater Than the 90th Percentile 
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Figure 90. Nebraska: Locations of Wells From Which Samples Were Collected 
and Analyzed For Chloride 

Figure 91. Nebraska: Locations of Wells Where Water Contained Chloride 
Concentrations Less Than or Equal to 125 mg/1 
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Figure 92. Nebraska: Locations of Wells Where Water Contained Chloride 
Concentrations Greater Than 125 mg/1 but Less Than or Equal 
to250mg/l 
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Figure 93. Nebraska: Locations of Wells Where Water Contained Chloride 
Concentrations Greater Than 250 mg/1 
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Figure 94. Nebraska: Locations of Wells Where Water Contained Chloride 
Concentrations Equal to or Greater Than the 90th Percentile 
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Figure 95. Nebraska: Locations of Wells From Which Samples Were Collected 
and Analyzed For Sulfate 
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Figure 96. Nebraska: Locations of Wells Where Water Contained Sulfate 
Concentrations Less Than or Equal to 125 mg/1 
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Figure 97. Nebraska: Locations of Wells Where Water Contained Sulfate 
Concentrations Greater Than 125 mg/1 but Less Than or Equal 
to250mg/l 
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Figure 98. Nebraska: Locations of Wells Where Water Contained Sulfate 
Concentrations Greater Than 250 mg/1 
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Figure 99. Nebraska: Locations of Wells Where Water Contained Sulfate 
Concentrations Equal to or Greater Than the 90th Percentile 
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Figure 100. Nebraska: Locations of Wells From Which Samples Were Collected 
and Analyzed for Nitrate Measured as N 

Figure 101. Nebraska: Locations of Wells Where Water Contained Nitrate 
Concentrations Less Than or Equal to 5 mg/1 as N 
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Figure 102. Nebraska: Locations of Wells Where Water Contained Nitrate 
Concentrations Greater Than 5 mg/1 as N but Less Than or 
Equal to 10 mg/1 as N 

Figure 103. Nebraska: Locations of Wells Where Water Contained Nitrate 
Concentrations Greater Than 10 mg/1 as N 
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Figure 104. Nebraska: Locations of Wells Where Water Contained Nitrate 
Concentrations, Measured as N, Equal to or Greater Than the 
90th Percentile 
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Figure 105. Nebraska: Locations of Wells From Which Samples Were Collected 
and Analyzed for Nitrate as N03 
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Figure 106. Nebraska: Locations of Wells Where Water Contained Nitrate 
Concentrations Less Than or Equal to 25 mg/1 as N03 
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Figure 107. Nebraska: Locations of Wells Where Water Contained Nitrate 
Concentrations Greater Than 25 mg/1 as N03 but Less Than or 
Equal to 45 mg/1 as N03 
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Figure 108. Nebraska: Locations of Wells Where Water Contained Nitrate 
Concentrations Greater Than 45 mg/1 as N03 
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Figure 109. Nebraska: Locations of Wells Where Water Contained Nitrate 
Concentrations, Measured as N03, Equal to or Greater Than 
the 90th Percentile 
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Kansas 

General Setting 

Kansas contains approximately 82,000 square miles. Annual average 

precipitation varies from less than 16 inches in the west to approximately 40 

inches in the southeast corner of the state. The northern part of the state is 

drained by the eastern flowing Kansas River and tributaries. The eastern to 

southeastern flowing Arkansas, Verdigris and Neosho River systems drain 

southern Kansas. 

Kansas is principally underlain by Paleozoic age clastic and carbonate 

sequences which dip gently westward. Mississippian age limestone is the 

oldest exposed bedrock that outcrops in the southeastern corner of the state. 

The remainder of the eastern part of Kansas is underlain by Pennsylvanian 

and Permian age bedrock that primarily consists of limestone and shale with 

some sandstone beds. Cretaceous age sequences of limestone and shale units 

make up the bedrock that outcrops in west-central Kansas. Capping the 

Cretaceous strata in the western portion of the state is the unconsolidated 

Ogallala Formation. The western half of Kansas is mantled by a thin 

discontinuous veneer of Quaternary age eolian and dune sand deposits. The 

far northeast corner is locally overlain by glacial drift deposits. Occurring 

along major stream systems are terrace and alluvial deposits that consist of 

gravel, sand, silt and clay. 

Discussion 

Table 8 exhibits the number of analyses measured, the percentage of 

samples that exceed E.P.A. drinking water standards, and the percentage in . 

each range of concentration. A map of the major aquifers in Kansas and their 
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descriptions is depicted in Figures 110 and 111. Maps illustrating the location 

of wells and selected ground water quality in Kansas are shown in Figures 

112-142. 

Forty four percent of the ground-water samples analyzed for total 

dissolved solids in Kansas exceeded the recommended limit of 500 mg/1. 

These wells are distributed somewhat evenly throughout the state. Data in 

Table 8 suggests that high levels of dissolved solids is related to the presence 

of very hard water which occurs throughout the state. More than 1100 

samples have been analyzed for hardness and 83 percent exceed 180 mg/1. 

Over 1100 wells were sampled for chloride in the state, with 85 percent 

equal to or less than 125 mg/1. Only 6 percent of the samples exceed the 

recommended level of 250 mg/1. Figure 127 shows chloride levels equal to or 

greater than the 90th percentile. These locations coincide with areas where 

oil and gas drilling activity has occurred. This activity could be the cause for 

the high levels of chloride in the ground water. 

Seventeen percent of the samples tested for sulfate exceed 250 mg/1. 

These wells are distributed somewhat evenly throughout Kansas without 

regard to major aquifer present. The elevated sulfate concentrations is 

probably related to the presence of gypsum. 

About 900 samples were analyzed for nitrate as Nand 750 samples were 

analyzed for nitrate as N03. Both are distributed evenly throughout the state. 

Figures 136 and 141 show that the locations of wells where nitrate 

concentrations exceed the recommended levels occur predominantly in the 

eastern two-thirds of the state. High levels of nitrate are most likely due to 

agricultural activities, being derived either from fertilizers or by bringing 

under cultivation grasslands that previously served for grazing. The change 



from grazing to cultivation commonly leads to the leaching of the large 

quantity of nitrate stored in the unsaturated zone. 
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TABLES 

KANSAS: NUMERICAL SUMMARIES 
OF WATER ANALYSES 

Chemical EPA Water Percentage Percentage 
Constituent Number Quality Exceeding in Each 
by Range of of Standard EPA Range of 

Concentration (mg/1) Samples (mg/l) Standard (%) Concentration(%) 

TDS 500* 44 • 
All Samples 804 • • 
0-500 451 • 56 
501 -1000 295 • 37 
Greater than 1000 58 • 7 
Equal to or Greater Than • • 

the 90th Percentile 84 • 10 

Hardness None • • 
All Samples 1135 • • 
0-60 34 • 3 
61 -120 44 • 4 
121 -180 114 • 10 
Greater than 180 943 • 83 
Equal to or Greater Than • • 

the 90th Percentile 110 • 10 

Chloride 250 6 • 
All Samples 1168 • • 
0-125 997 • 85 
126-250 96 • 8 
Greater than 250 75 • 6 
Equal to or Greater Than • • 

the 90th Percentile 117 • 10 

Sulfate 250 17 • 
All Samples 1170 • • 
0-125 788 • 67 
126-250 183 • 16 
Greater than 250 199 • 17 
Equal to or Greater Than • • 

the 90th Percentile 117 • 10 
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TABLE 8 (continued) 

Chemical EPA Water Percentage Percentage 
Constituent Number Quality Exceeding in Each 
by Range of of Standard EPA Range of 

Concentration (mg/1) Samples (mg/D Standard (%) Concentration(%) 

NitrateasN 10 15 • 
All Samples 902 • • 
0-5 610 • 68 
6-10 157 • 17 
Greater than 10 135 • 15 
Equal to or Greater Than • • 

the 90th Percentile 92 • 10 

Nitrate as N03 45 14 • 
All Samples 755 • • 
0-25 524 • 69 
26-45 123 • 16 
Greater than 45 108 • 14 
Equal to or Greater Than • • 

the 90th Percentile 76 • 10 
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EXPLANATION 

Alluvial Aquifers 

Glacial Drift Aquifers 

High Plains Aquifer 

Great Plains Aquifer 

Chase and Council Grove Aquifers 

Douglas Aquifer 

Ozark Aquifer 

Not a Principle Aquifer 

Figure 110. Kansas: Map of Major Aquifers (Modified from U.S.G.S., 1985) 
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fOal/..US • ....... per.W.ute;lai!L • aiDipalllsperlilcr;fl • r.t. Sooorc.: bparuofdleU.S.Gelllosical5urwyuwiK_.,.......) 

Well Chlractlll'latles 
Aquifer neme and dMcrlptiOn 

GIKial-4rift aquifer: 
Plciltocac aJacial clepooiu of 
clay. lliii.MIIII, uwlpawel. 
Galerdy -r....s. 

Oreal Plaifta aquifer: 
Dakoca uw1 Chcyenae 
Sandllonaorer­
aae. Galcrally UDCODiiDed. 

Owe and Cound1 Grove 
aquifer: Limestotlt!l of 
Chase and CouDcil Grove 
Groups of Permian aae. 
Galcrally UIICOIIfmell. 

Doullu aquifer: 
ChaJIDd sandstone of 
PCIIIISylvaniaJI qe. 
Generally IIIICODfJDid. 

Ozark aquifer: W•lllend 
and loll>dy clolomiaes of Arbuc:ltle 
Group. Cambrian and OrclcwidaD 
qe.Coafmed. 

Depth(ft) 
c:omn­

ranoe 
10-150 

10-300 

10-4!0 

20-200 

20-200 

S-400 

500-1,100 

Ylllcl (giUmln) Almaltla 
Common Mly 

range UCIICI 
10-500 1,000 Wdl,;ddaiDXusas,ABUIIU,a-blic:an, 

uw1 Pa-lli-vallcyla...S 500 pi/mill. 
Wells ill ocber vallcyl.....wly ,;old lallhul 
100pllmill. I.Gc:ally, -er I,_ alluvial 
aquifen culllve Juae__._. of 
~ IOticls. cbloride, sulfue, lliuue, iroD. 
w........-. Larae ca>ea~tmioasofiOie­
Di- uwl Ml1lniiJ o=arriD& ...-elplla 

ndioolcllvily ----·- fnllll -u..a ,.n ol Gnll PlaiDI. 

10- tOO 500 Wuer tram sllalow wells ...,....uy • c:akium 
bic:ut>oD&Ic type wicb loulluul500 laiiL 
diNolwd IOticls,llut Juae~ of 
lliualeca-. Wuer from«*pwdlsCIIJI 
uve lulf -.atioGs or clisloMd IOticls, 
cbloride • .UMe,irao, ar....-. 

500-1,000 1,500 W...,.JIIMrallyacU::iumllicarbooUelype 

10-100 

10-20 

10-40 

30-150 

wilh cooce&nllioos of 4illolwd IOiicb -
liwi500IIJI/L..,. ~arae--.or 

fllloride uwlldaliua --· -u.cra Oral Plalas. Pnwida -er lllll!'iiCII 
for Doclae City, Oarclal City, Onallleacl, 
Prau, HuiCblaooo. McPbcnoo, WJCbi&a, 
ud-ocber- ill (inal PlaiM. 

1,000 w ..... quali1y vanable. Cataum llicarbooUe 
type wuer wllh las liwl 500 maiL of 
dislohed solids produced wbcretbc aquifer 
is cxpoted. Sodium bicarbonate or IOdium 
cllloride lype-ter wilb lup _,..ions 
of diuol-.11 solids is produced wa1 IIIICI DOrth of 
tbc surface CllJ!OIIIft· Larae ca>ea1Ua1ions of 
iron OClCIII' iD-.. rrom lOGIC wdb. Some 
wells iD FJIIJIC)', Ford, uwl Hodpman Cowlliol 
Cllllyield-lhuii,OOOpl/aaiD. 

200 Water aaaaJ1Y a c:aJcium bicmboalte type 
wllh CODCCIIIralions of diuolved IOiids las 
llwi500!1111L. Wuer r,_- wdls CUI 
bavelaqe-ralionsofiUifue. Wcllsill 
Buller uwl Cowley Coulllies CID produce -er 
willllar,e c:ooc:entmioas of diuoi..S IOiids. 
Concct~tralions of dWolved IOiids uwl chloride 
luae- oftbc surf-apo~~~re, uwlwatcr 
inottlled. 

too Wucr ruaes from a c:alcium bicmboaate ~ype, 
will> las liwl500 IIIIIL of dWolved IOiids 
where aquifer is apoted. 10 a IOdium 
bicarboDuc or todium cllloride type, wllh 1uae 
~tralions or dislol¥ed solids u depth or 
Wlllofsurfaceapooure. Conceaualions 
of Ouoricle m.y be lar,e. EquivaieDIIO 
Vamoooa·Acla aquifer iD Oklahoma. 

500 Water JICIICI'.Uy a calcium bicarbooale type 
with Ins than 500 maiL of diuolved IOiids ill 
lbe Ozark Pllllealll uwl in extreme _.bast 
comer of lbe Osaae PW.... Sodium bicarboa­
ate chloride or llodium cllloride type water wilb 
larac concentrations of cliuol-..1 solids is 
produced ill rat of Or.aae PW.... Hydroten 
aulfllle ps, or 1uae CODCCDtralions of pou­
alpha radioactivity or iron, CID occur ill water 
from IOlDC wells. EAjui .. lent 10 Roubidoux 
aquifer iD Oklahoma. 

Figure 111. Kansas: Major Aquifer Descriptions and Well Characteristics 
(Modified from U.S.G.S., 1985) 
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Figure 112. Kansas: Locations of Wells From Which Samples Were Collected 
and Analyzed For Total Dissolved Solids . 
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Figure 113. Kansas: Locations of Wells Where Water Contained Total Dissolved 
Solids Concentrations Less Than or Equal to 500 mg/1 
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Figure 114. Kansas: Locations of Wells Where Water Contained Total Dissolved 
Solids Concentrations Greater Than 500 mg/1 but Less Than or 
Equal to 1000mg/l 

. . b . -z . 

~ 
. 

~.1 '---
. ~ . . . . .....____ 

• d . . .....-- . . 
• lo ~ . 

. . 1--- . . r-- tL-J . . . . . 
1--. 

. I 
. . ·r---:-. . . 

Figure 115. Kansas: Locations of Wells Where Water Contained Total Dissolved 
Solids Concentrations Greater Than 1000 mg/1 
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Figure 116. Kansas: Locations of Wells Where Water Contained Total Dissolved 
Solids Concentrations Equal to or Greater Than the 90th Percentile 
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Figure 117. Kansas: Locations of Weils From Which Samples Were Coilected 
and Analyzed For Hardness 
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Figure 118. Kansas: Locations of Wells Where Water Contained Hardness 
Concentrations Less Than or Equal to 60 mg/1 
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Figure 119. Kansas: Locations of Wells Where Water Contained Hardness 
Concentrations Greater Than 60 mg/l but Less Than or Equal 

· to120mg/l 
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Figure 120. Kansas: Locations of Wells Where Water Contained Hardness 
Concentrations Greater Than 120 mg/l but Less Than or 
Equal to 180 mg/l 
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Figure 121. Kansas: Locations of Wells Where Water Contained Hardness 
Concentrations Greater Than 180 mg/l 
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Figure 122. Kansas: Locations of Wells Where Water Contained Hardness 
Concentrations Equal to or Greater Than the 90th Percentile 
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Figure 123. Kansas: Locations of Wells From Which Samples Were Collected 
and Analyzed For Chloride 
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Concentrations Less Than or Equal to 125 mg/1 
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Figure 128. Kansas: Locations of Wells From Which Samples Were Collected 
and Analyzed For Sulfate 
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Concentrations Less 1ban or Equal to 125 mg/1 
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Equal to 250 mg/1 
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and Analyzed for Nitrate Measured as N 
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Concentrations Greater Than 45 mg/1 as N03 
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Oklahoma 

General Setting 

Oklahoma contains approximately 70,000 miles. Average annual 

precipitation ranges from 16 inches in the panhandle to over 52 inches in the 

southeastern corner of the state. The northern half of the state is drained by 

the eastern flowing Arkansas River system. This system includes the 

Cimarron, North Canadian and South Canadian Rivers. The southern part is 

drained by the Washita and Red River Systems. 

The majority of Oklahoma is underlain by thick sequences of upper 

Paleozoic age sandstone, shale, and limestone. Precambrian crystalline rock is 

exposed in the Arbuckle and Wichita mountains. Outcrops of folded and 

faulted Paleozoic age sandstone and shale occur in the Ouachita Mountains in 

the southeastern part of Oklahoma. Limestone, sandstone and shale 

formations of Cretaceous age cover the southeastern part of the state. The 

northwest margin is mantled by semiconsolidated Tertiary age deposits of 

sand and gravel known as the Ogallala Formation. Unconsolidated terrace 

and alluvial deposits that consist of sand, gravel, silt and clay lie along most 

rivers in Oklahoma. 

Discussion 

Table 9 exhibits the number of analyses measured, the percentage of 

samples that exceed E.P.A. drinking water standards, and the percentage of 

samples in each range of concentration. A map of the major aquifers in 

Oklahoma and their descriptions is depicted in Figures 143 and 144. Maps 

illustrating the location of wells and selected ground water quality in 

Oklahoma are shown in Figures 145-175. 
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More than 2000 samples were analyzed for dissolved solids, 83 percent 

exceeded the recommended limit of 500 mg/1, and 30 percent exceed 1000 

mg/1. Figures 147 and 148 shows that the wells with excessive dissolved 

solids are largely concentrated in central and western Oklahoma. The data 

and maps indicate that these high dissolved solids concentrations are due to 

high levels of hardness, chloride, and sulfate. The 90th percentile level of 

concentration for dissolved solids equals 3420 mg/1. Ten percent or 200 

samples are equal to or greater than 3420 mg/1 in Oklahoma. Figure 149 

shows that the location of wells where these samples were obtained are 

located in western Oklahoma, with a concentration of wells in the far 

southwest corner of the state. Figures 155, 160, and 165 depict samples which 

are equal to or exceed the 90th percentile for hardness, chloride, and sulfate 

respectfully. All three show a similar cluster in the southwest corner of the 

state. This indicates that the high dissolved solid content in this area is due to 

hardness, chloride and sulfate. The major aquifer in this area is the Dog 

Creek-Blaine which consist of interbedded gypsum, dolomite and siltstone. 

This aquifer is not used for drinking water but is used intensively for 

irrigation in the area. 

Almost 2200 samples were analyzed for hardness and 73 percent exceeded 

180 mg/1. Figure 154 shows that the locations of wells containing very hard 

water occur extensively in central and western Oklahoma. Figure 155 

indicates that the locations of wells where water contained hardness 

concentrations equal to or greater than the 90th percentile occur in 

southwestern, and to a lesser extent western Oklahoma. Hard water in the 

state is due to the widespread presence of carbonate and evaporite deposits. 

Over 3400 samples were analyzed for chloride in Oklahoma. 76 percent 

are less than or equal to 125 mg/1, and 15 percent of the samples exceed the 
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recommended limit of 250 mg/1. The highest concentration of wells is 

located in the southwest corner, but can be found throughout the state. High 

levels of chloride are likely to be due to deposits evaporite deposits as well as 

oil and gas drilling activity. 

Sulfate was analyzed in over 3200 samples with 23 percent exceeding 250 

mg/1. Figure 164 shows that the locations of wells where water contained 

sulfate concentrations greater than the recommended levels occur extensively 

in western Oklahoma. The lineation of wells which contain high levels of 

sulfate southeastern Oklahoma occur along a fault zone on the north side of 

the Ouachita Mountains. 

Approximately 12 percent of the samples tested for nitrates exceed the 

recommended limit. High nitrates occur almost exclusively in the western 

half of the state. This part of Oklahoma is used extensively for irrigated 

agriculture. Fertilizers are the probable cause for these high levels of nitrate. 
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TABLE9 

OKLAHOMA: NUMERICAL SUMMARIES 
OF WATER ANALYSES 

Chemical EPA Water Percentage Percentage 
Constituent Number Quality Exceeding in Each 
by Range of of Standard EPA Range of 

Concentration (mg/1) ·samples (mg/1) Standard (%) Concentration(%) 

TDS 500* 83 • 
All Samples 2002 • • 
0-500 946 • 47 
501 -1000 467 • 53 
Greater than 1000 595 • 30 
Equal to or Greater than • • 

the 90th Percentile 200 • 10 

Hardness None • • 
All Samples 2191 • • 
0-60 185 • 8 
61-120 131 • 6 
121-180 268 • 12 
Greater than 180 1607 • 73 
Equal to or Greater than • • 

the 90th Percentile 228 • 10 

Chloride 250 15 • 
All Samples 3416 • • 
0-125 2601 • 76 
126-250 315 • 9 
Greater than 250 500 • 15 
Equal to or Greater than • • 

the 90th Percentile 338 • 10 

Sulfate 250 23 • 
All Samples 3225 • • 
0-125 2154 • 67 
126-250 332 • 10 
Greater than 250 739 • 23 
Equal to or Greater than • • 

the 90th Percentile 318 • 10 
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TABLE 9 (continued) 

Constituent Number Quality Exceeding in Each 
by Range of of Standard EPA Range of 

Concentration (mg/1) Samples (mg/1) Standard (%) Concentration (%) 

NitrateasN 10 11 • 
All Samples 1471 • • 
0-5 1135 • 77 
6-10 168 • 11 
Greater than 10 168 • 11 
Equal to or Greater than • • 

the 90th Percentile 168 • 11 

Nitrate as N03 45 12 • 
All Samples 1480 • • 
0-25 1156 • 78 
26-45 153 • 10 
Greater than 45 171 • 12 
Equal to or Greater than • • 

the 90th Percentile 157 • 11 
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EXPLANATION 

Alluvium and Terrace Deposits Along 
Major Streams 
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Figure 143. Oklahoma: Map of Major Aquifers (Modified from U.S.G.S., 1985) 
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Figure 144. Oklahoma: Major Aquifer Descriptions and Well Characteristics 
(Modified from U.S.G.S., 1985) 
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Table 2. Aquifer and well characteristics In Oklahom8-Conllnuecl 

Aquifer Well characteristics 
withdrawals Q!eth!fll Yield !lilaUmln) 

Aquifer name and description In 1980 Common Common May Remarks 
(Mgalld) range range exceed 

Rush Sprinas aquifer: Fine-anined 54. 200-«10 200-600 1,000 Calcium bic:arbonale lype warer; 
sandsrone wilh some shale, dolomite, and dissolved-solids concernnlions 
aypsum; 200 10 300 ftthick. aenerally less than 500 mJIL. In 
Unconfined 10 panty confined in deeper heavily pumped areas, wa1er 
parts or aquifer. lcvcls have declined as mucll 

as !10 fl. 
DOl Creek-Blaine aquifer:lnterbedded 2~ 100-200 100-500 2,500 Generally calcium sulfate 

IYP•um. dolomire, and sillsrone, chloride rype water; tOial 
300 to «XX flrhick. W arer occurs in dissolved solids 2,000 to 
S<>llllinn openinas in cypsum; Jtntnlly 6,000 maiL. Unsuitable for 
unconfined. drink in&, but inlensively 

used for irriprion. Water 
levels may decline as much 
as 50ft, bur aquifer is recharaed 
by surface runoff into sinkholes 
and solution opcninJS. 

Garber-Wellin,lon aquifer' Fine- "' 100-200 100-300 500 Oenenlly calcium maanesium 
!!rained sand.rone with shale and (unconfined) bicarbonate type water; dissolved-
sih~tane; maximum thicknn!li about solids concentration aenerally las 
900 fl; saturated lhicknes< ISO 10 200-900 than 500 mall. Becomes more saline 
6~0 ft. Generally unconfined to (confined) with depth and in watem pan or 
partly confined where aquifer is near area. Underlain by sail water 
the surface or confined where overlain that may move upward in areas of 
by less permeable rocks. heavy pumpaJC. Locally, 

the potcnliometric surface has 
been lowered 100 to 200ft. 
Con1aminated by oil rJeld brines 
and wasta in some areas where 
aquifer is near surface. 

Vamoosa-Ada aquifer: Fine- to very 10 100-500 100-300 500 Generally sodium bicarbonate or 
fine-arained sandstone, sillstone, sodium calcium bicarbonate type 
shale, and conJiomerate. Thickness water; dissolved-solids 
or water-yieldinasandstone 100 to sso conc:mtration leas than 500 maiL, 
ft. Unconfined where near land but increase to 1,000 mall wirh 
•urface; confined in weot where depth near potable-water-salt-
overlain by Ieos permeable rocks. water interface. Estimated 60 
Equivalent to the Doualas aquifer million acre-ft of potable water 
in Kansas. in storqe. Most withdrawals for 

public and industrial use. 

Keokuk-Reeds SprinJ (Boone) aquifer: !10- 300 I- 10 10 Calcium bicarbonate typr water, 
Weathered re<idual chert and clay hard 10 very hard; dissolved-
in upper part; very cherty limeotone solids concentrations aenerally 
in lower part; maximum thicknes.• less than 500 mc/L. Because of 
~00 ft. Unconfined to confined. litholoay, readily susceptible 

to conramination frorn surface 
sources. Sprinp can yield 600 
to 3,500 pi/min. 

Roubidoux aquifer: Fractured dolomite s 100-1,200 150 600 Water moderately hard but suitable 
containinctwo or three sandy zones; for most uses. Principal water 
confined. Equivalent to Ozark aquifer supply for municipalities and 
in Kansas and Missouri. industries in Ottawa Coun1y. 

Arbuckle-Simpson aquifer: Limestone, 6 100-2,500 100-500 2,000 Calcium maanesium bicarbonate type 
dolomite, and sandstone 5,000 to water, very hard; dissolved-solids 
9,000 ft thick. Water occurs in concentralion aeneralty less than 
•olution openinss and fnetures; 500 mctl. Volume or water in 
confined to unconfined. storaae estimated to be 9 million 

acre-ft. SprinJS can yield as 
much as l8,00011llmin. 

1\rhuckle-Timbered Hills aquifer: 2 100-2,100 90-600 600 Water senerally soft, but nuoride 
Limestone, dolomite, sandy dolomite. concentrations exceed 1.6 m1fL 
mudstone, and conclomente; senerally nearly everywhcte and.may be as 
confined. much as JS mctL. Sprin1s can 

yield as much u 200 aalfmin. 

Figure 144. Continued 
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Figure 145. Oklahoma: Locations of Wells From Which Samples Were Collected 
and Analyzed For Total Dissolved Solids . 

. . ' . , . _ .. ~ . ..... ...• ' .... -
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138 

Figure 146. Oklahoma: Locations of Wells Where Water Contained Total Dissolved 
Solids Concentrations Less Than or Equal to 500 mg/1 



.... ~. . . .... ... 

Figure 147. Oklahoma: Locations of Wells Where Water Contained Total Dissolved 
Solids Concentrations Greater Than 500 mg/1 but Less Than or Equal 
to1000mg/l 

·"' .. 
... 

Figure 148. Oklahoma: Locations of Wells Where Water Contained Total Dissolved 
Solids Concentrations Greater Than 1000 mg/1 
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Figure 149. Oklahoma: Locations of Wells Where Water Contained Total Dissolved 
Solids Concentrations Equal to or Greater Than the 90th Percentile 
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Figure 150. Oklahoma: Locations of Wells From Which Samples Were Collected 
and Analyzed For Hardness · 

Figure 151. Oklahoma: Locations of Wells Where Water Contained Hardness 
Concentrations Less Than or Equal to 60 mg/1 
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Figure 152. Oklahoma: Locations of Wells Where Water Contained Hardness 
Concentrations Greater Than 60 mg/1 but Less Than or Equal 
to 120mg/l 

Figure 153. Oklahoma: Locations of Wells Where Water Contained Hardness 
Concentrations Greater Than 120 mg/1 but Less Than or Equal 
to 180mg/l 
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Figure 154. Oklahoma: Locations of Wells Where Water Contained Hardness 
Concentrations Greater Than 180 mg/1 

Figure 155. Oklahoma: Locations of Wells Where Water Contained Hardness 
Concentrations Equal to or Greater Than the 90th Percentile 
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Figure 156. Oklahoma: Locations of Wells From Which Samples Were Collected 
and Analyzed For Chloride 

Figure 157. Oklahoma: Locations of Wells Where Water Contained Chloride 
Concentrations Less Than or Equal to 125 mg/1 
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Figure 158. Oklahoma: Locations of Wells Where Water Contained Chloride 

Concentrations Greater Than 125 mg/1 but Less Than or Equal 
to250mg/l 

II • • 

Figure 159. Oklahoma: Locations of Wells Where Water Contained Chloride 
Concentrations Greater Than 250 mg/1 
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Figure 160. Oklahoma: Locations of Wells Where Water Contained Chloride 

Concentrations Equal to or Greater Than the 90th Percentile 
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Figure 161. Oklahoma: Locations of Wells From Which Samples Were Collected 
and Analyzed For Sulfate 

.. . . ,. . ... . ....... ~ 

Figure 162. Oklahoma: Locations of Wells Where Water Contained Sulfate 

Concentrations Less Than or Equal to 125 mg/1 
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Figure 163. Oklahoma: Locations of Wells Where Water Contained Sulfate 
Concentrations Greater 'Than 125 mg/1 but Less Than or Equal 
to250mg/l 

.. 

... 

Figure 164. Oklahoma: Locations of Wells Where Water Contained Sulfate 
Concentrations Greater Than 250 mg/1 
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Figure 165. Oklahoma: Locations of Wells Where Water Contained Sulfate 

Concentrations Equal to or Greater "Than the 90th Percentile 
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Figure 166. Oklahoma: Locations of Wells From Which Samples Were Collected 
and Analyzed for Nitrate Measured as N 

: . ,. .. .. . . ~ . . 
.,.~ ... 

Figure 167. Oklahoma: Locations of Wells Where Water Contained Nitrate 
Concentrations Less Than or Equal to 5 mg/1 as N 
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Figure 168. Oklahoma: Locations of Wells Where Water Contained Nitrate 
Concentrations Greater Than 5 rng/1 as N but Less Than or 
Equal to 10 mg/1 as N 

Figure 169. Oklahoma: Locations of Wells Where Water Contained Nitrate 
Concentrations Greater Than 10 rng/1 as N 
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Figure 170. Oklahoma: Locations of Wells Where Water Contained Nitrate 

Concentrations, Measured as N, Equal to or Greater Than 
the 90th Percentile 
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Figure 171. Oklahoma: Locations of Wells From Which Samples Were Collected 
and Analyzed for Nitrate as N03 

. . ,. 
·--~~ .... 

Figure 172. Oklahoma: Locations of Wells Where Water Contained Nitrate 
Concentrations Less Than or Equal to 25 mg/1 as N03 
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Figure 173. Oklahoma: Locations of Wells Where Water Contained Nitrate 
Concentrations Greater Than 25 rng/1 as N03 but Less Than 
or Equal to 45 mg/1 as N03 

Figure 174. Oklahoma: Locations of Wells Where Water Contained Nitrate 
Concentrations Greater Than 45 mg/1 as N03 
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Figure 175. Oklahoma: Locations of Wells Where Water Contained Nitrate 

Concentrations, Measured as N03, Equal to or Greater Than 
the 90th Percentile 
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CHAPTER VI 

SUMMARY AND CONCLUSIONS 

Summary 

The purpose of this study was to develop a practical method of obtaining 

andmapping ground water quality on a regional scale and to use this method 

to map selected ground water quality in North Dakota, South Dakota, 

Nebraska, Kansas and Oklahoma. The water analyses used for this 

investigation was obtained from the computer program Hydrodata QW. This 

program contains water quality data from the U.S. Geological Survey's 

National Water Data Storage and Retrieval System. This data base is widely 

considered to be one of the largest and accurate available. Once the data was 

accessed from Hydrodata QW, it was edited and mapped with the aid of 

desktop computers. The chemical parameters selected to represent the quality 

of the ground water was total dissolved solids, hardness, chloride, sulfate, and 

nitrate. All analyses were mapped by geographic location, by range of 

concentration in mg/1. Due to the relatively large aerial extent of the study 

area and vast quantity of data, the mapping scale of approximately 1: 5,000,000 

was used. Since this study is most likely to used as a quick and general 

reference, this scale was selected because it will fit on commonly published 

standard letter size paper. 
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Conclusions 

Based on the results of this the following conclusions may by made: 

1) The Hydrodata QW program is considered to be an acceptable data 

base due principally to the relatively large number of analyses it contains and 

the quality control for accuracy instituted by the U.S. Geological Survey. 

Another attribute of the program is that water quality data can be obtained via 

a personal computer. 

2) Deficiencies in the data base do exist. There are many analyses that do 

not include all major cations and anions, or measurements for organics or 

trace elements. A few well station locations are not accurately identified by 

the appropriate longitude and latitude. The number of analyses varies greatly 

from state to state. 

3) The maps provide a general representation of the selected ground 

water quality in North Dakota, Nebraska, Kansas and Oklahoma. Due to the 

small number of analyses in South Dakota one can not gain a meaningful 

understanding of the ground water quality in that state. 

4) A good understanding of basic DOS commands and fundamental 

operational procedures of both the PC and Macintosh computers is essential 

for timely execution for this type of data gathering and mapping 
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APPENDIX 

COMPUTER COMMANDS AND COMMENTS 

Introduction 

The following appendix itemizes the the steps and commands that 
were used in this investigation. Also included are pertinent comments. 
This procedure is divided into three main steps: (1) data base search, (2) 
analyses editing, and (3) mapping. 

Computer Hardware 

The computer hardware used for this investigation is as follows: (1) 
386 IBM compatible personal computer (hereafter referred to as PC), with 40 
megabyte hardrive and an optical disk drive (CD-ROM), (2) Macintosh llci 
desktop computer (hereafter referred to as Mac) with a removable hardrive, 
and (3) Laser Writer II printer. 

Computer Software 

The computer programs used on the PC are as follows: (1) Hydrodata 
QW by Earthinfo, (2) Wordstar release 4 by MicroPro, and (3) SEP 100 by Kelly 
Goff. Programs used on the Mac are Apple File Exchange by Apple and Atlas 
MapMaker 4.5 by Strategic Mapping. It is assumed that all software is properly 
loaded on the appropriate hardrives. 
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General Information 

The following table relates each step with the appropriate hardware 
and software. 

Step 

Data base search 

Analyses editing 
Analyses editing 
Analyses editing 

Mapping 

Software 

Hydrodata QW 

SEPlOO 
Words tar 

Apple File Exchange 

Map Maker 

Hardware 

PC 

PC 
PC 

Mac 

Mac 

The following excerpt from the user's manual describes the a typical 
sequence with this program: 
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"Example: you start by selecting items from the Station, Analysis, and 
Parameter menus that define the set of data you want. When this query is set 
up, you start the program to search and filter the data with the criteria in your 
query. You review the resulting data, scrolling through the Long or Short 
report form. After deciding what further use you want to make of the 
information, you export the data from the optical disc to a hard-disk file, and 
quit the program to analyze it" (Earthlnfo, 1989). 

This program is relatively user friendly because it is operated by the 
selection of menu options. A single line message located at the bottom of 
monitor presents a status message, such as "parsing query" or "retrieving 
data." This status line states what input is expected by the program, or gives 
other useful information. When you choose a menu item, a selection box 
opens below it. Knowledge of some basic commands are required for use. It is 
recommended to consult the users manual for complete operation of this 
program. The following commands will allow one basic use of the program: 

I 

Enter 

ESC 

Accesses the menu bar. 

Moves one down to a lower level. 

1) Takes one out of the menu that one is in and 
moves one back 1 level. 

2) Once at the main menu, ESC will return one to 
the menu screen one just came from. 



TAB 

Fl 

FS 

F6 

Arrow Up, Down 
Left, Right 

3) "ESC to abort" will appear in the message line 
when appropriate. 

Moves between data windows in the Long and 
Short reports. 

Gets you to the help screen. 

Marks a selection. 

Unmarks a selection. 

Allows one to move about the menu and the 
Results list. 
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Computer commands are in bold face type. Comments are in regular 
type. "Selection" of an item is done by using the arrow keys. One can see that 
an item has been "selected" because it will be highlighted. One can see that 
an item has been marked because the letters will be white in color instead of 
black. The "open" command is done by striking the enter or return key. 
Items in quotation marks are words that actually appear on the screen when 
the program is in use. 

Data Base Search 

This Hydrodata QW program is written on compact discs (CD-ROM), 
therefore, the PC must have an optical disc drive. The following commands 
will access the Hydrodata QW program. 

Turn on the PC computer 
Turn on monitor 
Turn on optical disc drive 
Insert the CD containing ground water analyses for ND, SD, NB, KS, and OK 

C> will appear, type the following: 

C>CDCDSYS 
C>MSCDEX /D:CDROM IL:L /M:2 
C>CD 
C>CD\CD\QUALITY 
C>QUALITY 

Enter 
Enter 

The Hydrodata QW title page will appear, then the menu will appear. 
The File menu will be highlighted. 



How to set up a query. 

Select the Station menu (by striking the arrow right key) 
Open the Station menu (by striking the enter key) 

A selection box will appear on the screen. 
Select the Site Code category (by striking the arrow down key) 
Open the Site Code category 

A selection box will appear. 
Select the Well (Groundwater) category 
Mark the Well (Groundwater) category (by striking the F5 key) 

Note: The program will search the data base for samples only taken 
from wells, not streams or springs or other sources. 

Strike the <n key 
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This will access the menu. The File menu will always be highlighted, 
after the (/) key is struck simply because it is the first one listed. 

Select the Parameter menu 
Open the Parameter menu 

A selection box will appear. 
Select the Parameter category 
Open the Parameter category 

The parameter list will appear, with both the parameter number and 
its description. The parameters are listed in order by parameter 
number. 

The following is a list of the 20 parameters searched for in the data base. 

Parameter Number 

00011 
00095 
00440 
00403 
00618 
00900 
00915 
00925 
00930 
00935 
00940 
00945 
00950 
00955 
01020 
01046 
70300 

Parameter Description · 

Temperature (degrees Fahrenheit) 
Specific Conductance (micromhos) 
Bicarbonate (mg/ 1) 
pH (standard units) 
Nitrate, dissolved (mg/1 as N) 
Hardness, total (mg/1 as CaC03) 
Calcium, dissolved (mg/1 as Ca) 
Magnesium, dissolved (mg/1 as Mg) 
Sodium, dissolved (mg/1 as Na) 
Potassium, dissolved (mg/1 asK) 
Chloride, dissolved (mg/1 as Cl) 
Sulfate, dissolved (mg/1 as S04) 
Fluorine, dissolved (mg/1 as F) 
Silica, dissolved (mg/1 as Si02) 
Boron, dissolved (mg/1 as B) 
Iron, dissolved (ug/1 as Fe) 
Dissolved Solids, residue on evaporation 

at 180 degrees C (mg/1) 



Nitrate, dissolved (mg/1 as N03) 
Depth of Well, total (ft) 
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71851 
72008 
72019 Depth Below Land Surface, water level (ft) 

There are hundreds of parameters to choose from in this program. One can 
scroll through the list by using the arrow or page down keys. A simple and 
fast method of locating the desired parameters is by using the Locate menu. 

After you have accessed the parameter list, get back to the menu by following 
command. 
I 
Select the Locate menu 
Open the Locate menu 

A selection box will appear. 
Select the Find by Code (F3) Category 
Open the Find by Code (F3) Category 
A "Search Window" box will appear. 
Type in the the parameter number for temperature, degrees F., which is 

00011, Enter 
The program will quickly search for the number and the parameter will 
appear highlighted on the screen. 
Mark the temperature, degrees F. parameter (by striking the FS key) 
The letters will now be white, indicating a Marked parameter. 
Access the menu · 
I 
Select the Locate menu 
Open the Locate menu 
Select the Find by Code (F3) Category 
Open the Find by Code (F3) Category 
A "Search Window" box will appear. 
Type in the the parameter number for specific conductance, which is 

00095, Enter 
Mark the specific conductance parameter 

Continue repeating this process until all remaining parameters have been 
marked 

Once all parameters have been marked access the menu 
I 

How to Save a Query 

One data base file is to be constructed for each state in the study area. In order 
to save time this query containing samples obtained from wells and 
the 20 parameters listed above will be saved in the program and 
recalled to be ran in conjunction with a specific state. By saving this 
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query one does not have reconstruct it five separate times. That is one 
time for each of the five states. 

Select the File menu (it should already be highlighted when the menu was 
accessed) 

Open the File Menu 
Select the Save category 
Open the Save category 
A "Save" box will appear. 
One can save a query or one can save a query and results. 
The arrow key acts as a toggle switch for the two choices 
Select the Query option 
Strike the tab key to access the Filename window 
Type in a filename for this query (PAR is one suggestion) 
Note: Write this down. This is done so that you will know which query 

filename is associated with which query, if you have more than one. 
Strike the Enter key 
A box will appear stating the approximate size in kilobytes of the query. 
Select yes and strike enter to save the query 
The query containing samples obtained only from well and the 20 parameters 

are now saved to the program under the filename PAR. 

How to Load a Saved Query 

Select the File menu 
Open the File menu 
Select the Load category 
Open the Load category 
A "Load" box will appear. 
One has the option of loading a query or one can load a query and results. 
The arrow key acts as a toggle switch for the two choices. 
Select the Query option 
Strike the tab key to access the Filename window 
Type in the filename, PAR 
Strike Enter 
The PAR query is now loaded. 

Adding to the Query 

Now that the PAR query is loaded we can add a geographic location filter such 
as Oklahoma. That is construct a query so that it will search for 
analyses that have been obtained from wells only located in 
Oklahoma and contain one or more of the 20 parameters selected. 

Select the Station menu 
Open the Station menu 



A selection box will appear 
Select the State category 
Open the State category 
The following states will appear: Alaska, Hawaii, Idaho, Kansas, Montana, 

Nebraska, North Dakota, Oklahoma, Oregon, South Dakota, Texas, 
and Washington. 

Select Oklahoma (Do not strike Enter, just highlight Oklahoma) 
Mark Oklahoma by striking FS 
Access the menu. 
I 
The new query is complete. 

How to Start a Query Search 
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Now that the query has been established, one can search the program for the 
desired analyses. 

Select the Locate menu 
Open the Locate menu 
A selection box will appear 
Select the Begin Search category 
Strike Enter to start the search . 
The program will search the data base for the analyses that were defined by 

the query. This process will take about 26 hours for the state of 
Oklahoma. When the search is complete a message box will appear 
in the center of the screen stating, "The database search has 
completed, strike any key to continue". 

Also on the screen a Results list will appear. The Results List contain the 
station name, station ID, number of analyses, and number of 
parameters. 

Strike any key 
Access the Menu 
I 
Select the File menu 
Open the File menu 
Select the Export category 
Open the Export category 
An Export box will appear. 
The Export box will have four subcategories: "Export Results, File Type, Data 

Format, and Filename". 
In the "Export Results" subcategory one has the option of exporting all the 

Results or only Marked Results. 
Select "All" 
In the "File Type" subcategory one has the option of ASCIT, Binary, Card, 

dBase, or Lotus file formats. 



Select "Card" 
In the "Data Format" subcategory on has the option of Long Report, Short 

Report, or Results List. 
Select "Long Report" 
In the "Filename" subcategory type in the filename that will identify the 

analyses. 
Type in C:OKLA 
Strike Enter 
A box will appear stating the approximate size of the file in kilobytes and a 

question asking if you wish to export this file. 
Select yes 
Strike Enter 
The file has now been exported to the hardrive. Make sure that there is 

enough room on the hardrive to store this information. 
Access the menu 
I 
Select the File menu 
Open the File menu 
Select the Quit category 
Strike Enter 
A box will appear asking if you wish to exit the program 
Select yes 
Strike Enter 
The program has now been exited. 

· C> will appear. 

Since these state files are so large (approximately 10 kilobytes) they must 
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be edited and transfered to a floppy disk before the next state file can 
created. 

Analyses Editing 

SEP100 

The state file OKLA has been created on Hydrodata QW and 
transferred to the hardrive (drive C). The file must be edited and condensed. 

With C> appearing on the screen, access SEP 100 by the following command: 
C>SEPlOO 
The following question will appear on the screen: "Enter File Name?" 
TypeinOKLA 
The program will locate and edit the file. Actually, two new files will be 

created; OKLA.ll and OKLA.dat. 
C> will appear on the screen when this editing process is complete. 



Word Star 

The OKLA.ll and OKLA.dat files contain spaces that will not allow 
the MapMaker program to read them. With the use of WordStar 
these unwanted can be easily removed from the files. 

With C> appearing on the screen, access WordStar by the following 
command: 

C>WS 

Editing the OKLA.ll file 

The first step is to open a nondocument, by the following command: 
Type inN 
The following question will appear: "Nondocument to open?" 
Type in OKLA.ll 
Strike Enter 
TypeinAQA 
The following question will appear: "Find What?" 
Strike the spacebar 
Strike Enter 
The following question will appear: "Replace with?" 
Strike Enter 
The following question will appear: "Option(s)?" 
TypeinGN 
Strike Enter 
The program will begin editing. 
After the editing is complete, 
Strike ESC 
Strike Enter 
TypeinAKD 
This will save the edited OKLA.ll file 
After the file has been saved the main menu will appear. 

Editing the OKLA.dat file 

The first step is to open a nondocument, by the following command: 
Type inN 
The following question will appear: "Nondocument to open?" 
Type in OKLA.dat 
The file will appear 
Arrow down one line 
TypeinAQA 
The following question. will appear: "Find What?" 
Strike the spacebar 
Strike Enter 
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The following question will appear: "Replace with?" 
Strike Enter 
The following question will appear: "Option(s)?" 
TypeinRN 
Strike Enter 
The program will begin editing. 
After the editing is complete, 
Strike ESC 
Strike Enter 
TypeinAKD 
This will save the edited OKLA.dat file. 
After the file has been saved the main menu will appear. 
Strike X to exit WordStar 
The OKLA.ll and OKLA.dat files have now been edited. 
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Transferring the OKLA.ll and OKLA.dat Files From the Hardrive to a Floppy 

The files are now properly edited and are of a size so that they can be 
copied to a high density 3.5 inch floppy disk. The disk must be formatted in 
the usual manner. 

Insert the formatted disk into drive B. 
With C> appearing on the screen, type the following command: 
C>COPY C:OKLA.Il B: 
After this process is complete, type the following command: 
C>COPY C:OKLA.dat B: 
Both the OKLA.ll and OKLA.dat files should now be on the floppy disk. 

Apple File Exchange 

The OKLA.ll and OKLA.dat files were created on the PC, in a MS-DOS 
format. The MapMaker program is ran on a Macintosh computer. The Apple 
File Exchange program makes a M5-DOS file readable on a Macintosh 
computer. 

Tum on the Macintosh computer 
Access the Apple File Transfer program 
A box titled "Apple File Exchange" will appear on the screen. 
·Insert the floppy containing the OKLA.ll and OKLA.dat files 
The Macintosh HD (hardrive) directory will be on the left and the floppy disk 

directory will be on the right. 
Select Text transaction from the MS-DOS to Mac menu 
A box titled "For converting M5-DOS to Mac" will appear. 
Select OK 
A box titled "Apple File Exchange" will appear on the screen. 
Select the OKLA.ll file from the floppy disk directory 



Select Translate 
Select the OKLA.DAT file &om the floppy disk directory 
Select Translate 
The OKLA.ll and OKLA.dat files should now be in the Macintosh directory 

and ready for use on the Macintosh. 
Select Quit from the Edit menu 
The floppy disk should automatically eject. 
The main menu should appear. 

Mapping 

MapMaker 

The files are now readable on the Macintosh. The locations of the 
wells where the samples were taken are now ready to be mapped. 

Access the Map Maker program 
The menu will appear. 

How to Convert a Text File to a Boundary File 

Select Convert Boundary Files from the File Menu 
A box titled "What do you want to convert?" will appear . 
. Select Text to Map Maker Boundary 
Select OK 
A box titled" In what form are your coordinates?" will appear. 
Select Latitude/Longitude 
Select OK 
A box titled" What projection method do you want to use?" will appear. 
Select None- use actual Lat!Long 
Select OK 
The Macintosh HD directory will appear. 
Select OKLA.ll 
Select Open 
A box titled "MapMaker Boundary File:" will appear. 
A box to type in a new file name is also on the screen. 
Type in CONV-OKLA.ll 
This will allow one to distinguish a converted .11 file and one that is not. 
Select Save 
The main MapMaker menu will appear. 
There is no need to convert the OKLA.dat file because it is data file. 

How to Create a Map 

Select New under the File 
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A box titled "Specify the way you would like to use the map boundary files to 
create your map" will appear. 

Select Combine Several Complete Files 
Select OK 
A box with the Macintosh HD directory will appear. 
Select the MapMaker file 
Open the MapMaker file 
A box with the MapMaker directory will appear. 
Select US Cnty Bndy 
Open the US CNTY BNDY file 
A box with the US County Boundary directory will appear. 
Select OK Cnty LL Bndy 
Open the OK CNTY LL BNDY file 
A box titled "Select the layer to which you want to add boundaries" will 

appear. 
Select the Based Map option (it should be highlighted) 
Select Add Boundary 
A box with the Macintosh HD directory will appear. 
Select the CONV -OKLA.ll file 
Open the CONV -OKLA.ll file 
A box· titled "Select the layer to which you want to add boundaries" will 

appear. 
Select Done 
A box will titled "Specify map size and position" will appear. 
Select OK. use Rectangle 
A county map of Oklahoma with all locations of wells that were sampled for 

the 20 parameters will appear. 
Select Import Data from the File menu] 
A box titled "Base map category and data values import options" will appear. 
Select Category Names and Data Values option 
A box with the Macintosh HD directory will appear. 
Select the OKLA.dat file 
Open the OKLA.dat file 
The program will read the file and a map will appear. 

As an example, the following commands will produce a map of Oklahoma 
with the locations of the wells where water contained chloride of less 
than or equal to 500 mg/1. 

Select chloride under the Category menu 
Select Data Divisions under the Assign menu 
A box will titled "Assign data divisions" will appear. 
In the Number of Divisions (1 - 35) category type in 1 
In the Oassification Method category select the Manual Entry option 
A box titled "Specify Data Range for Division 1 of 1" will appear. 
In the Minimum category type in 0 



In the Maximum category type in 500 
Select OK 
The map will appear. 
Select save from the File menu 
Name the file OK GW Quality 
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The file contains all parameters. To map other parameters just select this file 
and change categories and/ or concentration levels. 

How to Print a Map 

Select Page Setup under the File menu 
A box titled "LaserWriter page setup will appear" 
In the reduce or enlarge category type in 75 
Select OK 
Select Print under the File menu 
A box titled "LaserWriter" will appear. 
Select OK 
The map will be printed. 

Creating Data Base Files for Other States 

Once one is assured that the edited .ll and .dat files contain the information 
desired and function properly, these files can be deleted from the 
PC hardrive. This will create the needed space to create the data base 
for another state. 
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